3 Using the Interface ................................................................. 31

3.1 Your First Look at the SAS Ontology Management Studio User Interface 32
3.2 Understanding the Interface Components ................................. 34
   3.2.1 Menu Bar ........................................................................ 35
   3.2.2 Standard Toolbar ............................................................. 37
3.3 Classes Tab ........................................................................... 38
   3.3.1 Before You Use the Classes Tab ....................................... 38
   3.3.2 Ontology Pane ................................................................. 39
   3.3.3 Class Editor Section ......................................................... 40
   3.3.4 Add a Slot Dialog Box ..................................................... 45
3.4 Slots Tab ............................................................................... 46
   3.4.1 Before You Use the Slots Tab .......................................... 46
   3.4.2 Understanding Slot Types ............................................... 47
   3.4.3 Taxonomy Pane ............................................................... 48
   3.4.4 Slot Editor Section ........................................................ 49
3.5 Instances Tab ......................................................................... 54
   3.5.1 Before You Use the Instances Tab ................................... 54
   3.5.2 Taxonomy Pane ............................................................... 56
   3.5.3 Instances Section ............................................................ 59
   3.5.4 Instance Editor Section .................................................. 61
3.6 Hierarchy Tab ......................................................................... 64
   3.6.1 Before You Use the Hierarchy Tab ................................... 64
   3.6.2 Taxonomy Pane ............................................................... 65
   3.6.3 Instances Section ............................................................ 66
   3.6.4 Instances Editor Section ................................................ 67
3.7 Queries Tab ............................................................................. 67
   3.7.1 Before You Use the Queries Tab ..................................... 67
   3.7.2 Query Section ................................................................. 68
   3.7.3 Search Results Section .................................................. 70
3.8 Preferences Dialog Box .......................................................... 72
3.9 Importing and Exporting Projects ........................................... 77
   3.9.1 Understanding Import and Export Operations .................. 77
   3.9.2 Use the Export Project Wizard ....................................... 77
   3.9.3 Import Project Wizard .................................................... 79
3.10 User Management ................................................................. 82
About This Book

Audience

SAS Ontology Management Studio is designed for the following users:

- Ontology engineers who develop the metadata classifications for the information stored in your organization’s repositories.
- Taxonomists who develop Categories and Concepts to classify your data.
- Linguists and other persons who define the Constraints that determine the metadata.
- Persons responsible for querying and analyzing the Instances defined using the specified metadata.

You could be assigned a specific function, or you might develop a project by yourself.

Prerequisites

Here are the prerequisites for using SAS Ontology Management Studio:

- A user ID and password for logging on to SAS Ontology Management Studio and information about the repository where the project resides.
- Access to data sources that can be used to construct the metadata for your stored information.
- Access to representative documents where the information that you want to use to construct metadata is located.
# Conventions

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| TGM_ROOT   | The root directory where SAS Ontology Management Studio is installed, typically the following:  
  **Windows**: C:/Program Files/SAS/SAS Ontology Management Studio  
  **UNIX**: /opt/SAS Ontology Management Studio |
| _tstmgr    | The code examples for the _tstmgr file are shown in a fixed-width font. |
| More button| The labels for user interface controls are shown in a bold, sans serif font. |
| Top        | The names of taxonomy nodes appear in a fixed-width font. |
| www.sas.com| The hypertext links are shown in a light blue, fixed-width font, and are underlined. |
| ![Question Mark](image) | The Question Mark button accesses *SAS Ontology Management Studio: User’s Guide* in PDF format. |
1
About SAS Ontology Management Studio

- What is SAS Ontology Management Studio?
- Benefits to Using SAS Ontology Management Studio
- Architecture

1.1 What is SAS Ontology Management Studio?

It is increasingly important today to identify and maintain consistent and centralized metadata across textual repositories. This metadata enables search-and-retrieval engines to systematically identify the key concepts in the data stored in your organization’s repositories.

Easy ontology creation

The taxonomy structure that is provided in the various tabs that comprise the SAS Ontology Management Studio user interface enable you to create organized structures for the classifications of metadata.

Easy metadata definitions

Easily define the Slots that contain the Constraints for your metadata. Specify the types of information and the parameters of these data types by customizing the Slots that identify the metadata for each Class, or classification of data. You can also apply the Slots created in one Class to another classification of information.

Define the instantiations of your data

Define data instantiations based on the data allowed by the custom Slots that you create for each Category or Concept Class. Create hierarchical or inverse relationships between Instances to understand existent relationships between otherwise unrelated data.
Query your instantiations

Perform search-and-retrieval operations on the data that you defined. You can also use this functionality to replace information.

Sample Project

Use the sample SAS Ontology Management Studio project that is included with SAS Ontology Management Studio.

1.2 Benefits to Using SAS Ontology Management Studio

SAS Ontology Management Studio provides the following benefits:

Identify relationships between data

SAS Ontology Management Studio identifies the explicit, as well as the implicit, relationships between otherwise isolated pieces of data within your repositories. When you identify the metadata that defines this information, you can easily use this to identify the members of the Category and Concept Classes that classify your data.

Integrate information across your organization

SAS Ontology Management Studio enables you to identify the semantic terms that locate data that might otherwise be overlooked in the search and retrieval efforts for related information.

Use permission setting to control appropriate access levels

Use the permission setting features of SAS Ontology Management Studio to enable appropriate access, according to each user’s subject matter expertise, to your project. Using this feature, you can set these access levels to various parts of the project.

 Saves money on training and support costs

Maximize the value of the data in your repositories by using SAS Ontology Management Studio to identify, and classify, this information. Use the customizable features in this product to organize and locate the information that you are seeking.
1.3 How does SAS Ontology Management Studio Work?

SAS Ontology Management Studio is an application that anyone can use to manage content by developing an ontology for the metadata stored in your organization’s repositories. When this solution is integrated with SAS Content Categorization Studio and SAS Content Categorization Server, input documents are automatically tagged according to defined taxonomies.

1.4 Architecture

In order to create projects that classify and identify large amounts and types of information, the data sources are stored on a repository on a server. Individual users and groups of developers can access this repository at their workstations by connecting to the SAS Ontology Management Studio project that is also located on the server. See the diagram describing the architecture below.

*Figure 1-1 SAS Ontology Management Studio architecture*
2 Installing and Configuring the Software

- Overview of Installing and Configuring
- Understanding Prerequisite System Requirements
- Installing and Configuring the Database Server
- Installing _tstmgr
- Setting Up ODBC Data Sources
- Administrative Setup
- Client Setup
- Connecting to the Database
- Understanding the Cached Project

2.1 Overview of Installing and Configuring

This chapter is written primarily for administrators who install and configure the database and data sources. All other users see Section 2.7 Client Setup on page 23.

Before you can install and run SAS Ontology Management Studio you, as the administrator use the following steps:

1. Check your operating system configurations. For more information, see Section 2.2 Understanding Prerequisite System Requirements on page 6.

2. Install SQL Server. For more information, see Section 2.3 Installing and Configuring the Database Server on page 7.
3. Install the _tstmgr utility that is used to configure the SQL Server database for SAS Ontology Management Studio. For more information, see Section 2.4 Installing _tstmgr on page 10.

4. Create the first data source and use it to initialize the database. For more information, see Section 2.6.2 Initialize the Database on page 19.

5. Create the second data source and add users. For more information, see Section 2.6.3 Add Users on page 21 that uses Section 2.5 Setting Up ODBC Data Sources on page 10.

One example of the location of the software applications on machines running either Windows or Linux is displayed in the figure below:

2.2 Understanding Prerequisite System Requirements

This section provides information for the SAS Ontology Management Studio installation kit that includes the _tstmgr utility that is available for Windows (_tstmgr.exe), and for Linux (_tstmgr) and that also includes the SAS Ontology Management Studio installer (Setup.exe).

You, as a system administrator, can install SAS Ontology Management Studio.

Make sure that the system where you install the SAS Ontology Management Studio is configured in accordance with the recommended system configuration:
- **CPU**: x86 with 1 GHz or higher required, and 2+ CPUs of 2 GHz or higher, each, are recommended
- **RAM**: 1 GB or higher is recommended, but this base number depends on the size of the project that you have loaded

See the list of supported operating systems and the platforms required to run SAS Ontology Management Studio in the table below:

### Table 2-1: Supported Operating Systems

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux, (Red Hat 7.x, 8, 9, Fedora 1-3, RHEL 2.1 and higher), Suse</td>
<td>x86, x86-64</td>
</tr>
<tr>
<td>IBM AIX</td>
<td>PPC</td>
</tr>
<tr>
<td>FreeBSD</td>
<td>x86</td>
</tr>
<tr>
<td>HP-UX 32</td>
<td>PA-RISC</td>
</tr>
<tr>
<td>Sun Solaris (32-bit)</td>
<td>x86</td>
</tr>
<tr>
<td>Sun Solaris (32-bit)</td>
<td>SPARC</td>
</tr>
<tr>
<td>Sun Solaris (64-bit)</td>
<td>UltraSPARC</td>
</tr>
<tr>
<td>Tru64 UNIX</td>
<td>HP Alpha</td>
</tr>
<tr>
<td>Windows</td>
<td>x86</td>
</tr>
</tbody>
</table>

### 2.3 Installing and Configuring the Database Server

#### 2.3.1 Install MySQL Server

You install a SQL-based database server on your server in order to set up a repository for SAS Ontology Management Studio. MySQL is certified at this point in product development.

Install MySQL Server using the following link:
The following changes to the server configuration are recommended to ensure smooth SAS Ontology Management Studio usage if you plan to create Classes with large numbers of Instances:

2.3.2 Edit the my.conf File on Linux

Use the steps in the following example to change the size of data in the my.cnf file:

1. Copy the my-xxx.cnf file from /usr/share/mysql to /etc as my.cnf.

2. The size of the, for example, xxx file, can vary from small to large, depending on your requirements. Locate the file whose location depends on the MySQL Server installation, for example:
   ```bash
   cp /usr/share/sqlfilename /etc/my.cnf
   ```
   or:
   ```bash
   cp /usr/share/sqlfilename /etc/mysql/mysql.cnf
   ```

3. Change the following default setting in the my.cnf file:
   ```bash
   max_allowed_packet = 1M
   ```
   to:
   ```bash
   max_allowed_packet = 32M
   ```

**Note:** Use the following three steps when you plan to create a project with 100,000 or more Instances. If not, go to Step 7. and Step 8. below.

4. Change the following default settings, or add this line to the my.cnf file:
   ```bash
   query_cache_size = 64M
   ```

5. Change the following default setting, or add this line to the my.cnf file:
   ```bash
   sort_buffer_size = 64M
   ```

6. Change the following default settings, or add these lines to the my.cnf file:
   ```bash
   innodb_buffer_pool_size = 1G
   innodb_file_per_table
   ```
7. Save the file.
8. Restart MySQL Server using the following command:
   
   `/etc/init.d/mysql restart

2.3.3 Edit the my.ini File on Windows

Use the steps in the following example to increase the allowed packet size of data in the MySQL Server program directory:

1. Open the `my.ini` file that was either installed, or created when you configured the server. Use the following, or a similar, location:
   
   `C:\Program Files\MySQL\MySQL_Server`

2. Change `max_allowed_packet = 1M` under the `The MySQL Server` [mysqld] section to:
   
   `max_allowed_packet = 32M`

   **Note:** Use the following three steps when you plan to create a project with 100,000 or more Instances. If not, go to Step 6. and Step 7. below.

3. Change the following default settings, or add this line to the `my.ini` file:
   
   `query_cache_size = 64M`

4. Change the following default setting, or add this line to the `my.ini` file:
   
   `sort_buffer_size = 64M`

5. Uncomment and edit the following settings, or add these lines to the `my.ini` file:
   
   `innodb_buffer_pool_size = 1G`
   `innodb_file_per_table`

6. Save the file.
7. Restart MySQL Server. Select **Control Panel --> Administrative Tools --> Services --> MySQL.**
2.4 Installing _tstmgr

Before you can configure your ODBC data sources, you install _tstmgr. The _tstmgr utility is a command line program that complements the functionality of the SAS Ontology Management Studio graphical user interface application for Windows. This program is shipped in a package with a name that is similar to the example shown below:

_tstmgr_commandline.zip

You can download this zip file onto your computer and extract its files into the location of your choice.

2.5 Setting Up ODBC Data Sources

2.5.1 Understanding How to Use ODBC Drivers

Install and configure the ODBC driver connectivity software on the server and client systems that are used to access the SAS Ontology Management Studio project repositories.

SAS Ontology Management Studio uses three types of ODBC data sources:

- This ODBC driver points to the SQL Server database and is used by the database administrator to create the SAS Ontology Management Studio database on the server. For more information, see Section 2.6.2 Initialize the Database on page 19.

- This ODBC driver points to the SAS Ontology Management Studio database. Administrators, with at least project permissions, can use this driver to create a data source that is located on the server and to add users to this database. For more information, see Section 2.6.3 Add Users on page 21.

- Both regular users and administrators can use this ODBC driver to create a data source on a local machine that points to the SAS Ontology Management Studio database. For more information, see Section 2.7 Client Setup on page 23.
For information that is applicable to all three database configurations, see Section 2.5.3 Configuring Data Sources on page 12.

2.5.2 Installing the ODBC Drivers

SAS Ontology Management Studio and _tstmgr use ODBC drivers to connect to the database repositories.

**Note:** To install the ODBC software, make sure that you permission levels are set to perform this installation.

You can download the ODBC drivers for the, for example, MySQL Server, for either Windows or Unix operating systems. Go to the following location and follow the directions you find there:

### 2.5.3 Configuring Data Sources

#### 2.5.3.A Understanding How to Configure Data Sources

Use the following credentials to configure each of the three data sources that are required to run SAS Ontology Management Studio and \_tstmgr. See Section 2.5.3.B *Configure Data Sources on Unix* on page 13, or Section 2.5.3.C *Configure Data Sources on Windows* on page 15. The credentials that supply the different information required to create the three different kinds of data sources, are listed below:

<table>
<thead>
<tr>
<th>Name</th>
<th>User</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| For information applicable to all three database configurations, see Table 2-3 on page 20. Examples of these credentials are provided for each of the following three data sources that you create:

- Administrators with database permissions should see Section 2.6.2 *Initialize the Database* on page 19 to set up the first data source. This administrator uses these credentials, as well as the other information provided in this section, to create a SAS Ontology Management Studio database on the server.

- Administrators who have a minimum of project permissions should see Section 2.6.3 *Add Users* on page 21 to set up the second data source. This administrator uses these credentials, as well as the other information provided in this section, to create a data source adding users to the SAS Ontology Management Studio database.

- Regular users and administrators can both use the example of credentials shown in Section 2.7 *Client Setup* on page 23 to set up the third data source. Regular users and administrators use these credentials, as well as the other information provided in this section, to install SAS Ontology Management Studio.
2.5.3.B Configure Data Sources on UNIX

From UNIX, all ODBC data sources are configured using an odbc.ini file that is either in the path specified by the ODBCINI environment variable or in the user’s home directory. (If the odbc.ini file is stored in /etc, it is not writeable.) To create a local .odbc.ini file, create a file with this name in your home directory, by hand—if necessary. See the following link for details on the file format:

http://www.iiodbc.org/index.php?page=docs/faq#iodbc237887083

You can also use the graphical data source administrative tool, if this tool is installed on your system.

Use the sample odbc.ini file displayed in Example 2-1 below to either create or to modify your odbc.ini file:

Example 2-1: A Local odbc.ini File

```ini
;
; odbc.ini
;
[ODBC Data Sources]
data_source_name1 = ODBC Driver for SQL Server
data_source_name2 = ODBC Driver for SQL Server

[data_source_name1]
Driver       = /usr/lib/odbc/libmyodbc.so
Server       = 127.0.0.1
Port         = 3306
Database     = database_name

[data_source_name2]
Driver       = /usr/lib/odbc/libmyodbc.so
Server       = server_name
Port         = 3306
Database     = database_name
```

Use the second example to create your third data source as well as your second data source.

As shown in the example above, each data source is specified using a separate line that appears below [ODBC Data Sources]. This section of the odbc.ini file lists all of the ODBC data sources. Below this section, you can specify...
each data source name followed by separate lines detailing the driver, server, port, and database parameters.

Table 2-2: Data Source Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Driver</strong></td>
<td>Specify the name and location of the driver library that is installed as part of the SQL Server connector ODBC driver. The name of this file is, for example, libmyodbc.so.</td>
</tr>
<tr>
<td><strong>Server</strong></td>
<td>Specify the name of the machine where the SQL Server is running. Use 127.0.0.1 instead of localhost because SQL Server is running on the same machine as the ODBC data source.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Specify the number of the port that connects with SQL Server. Use 3306 unless SQL Server has been configured to use another port.</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>Specify the name of the database that can be accessed using this data source.</td>
</tr>
</tbody>
</table>
2.5.3.C Configure Data Sources on Windows

Both administrators and regular users follow these steps to create their respective data sources. Information that is specific to each type of data source is included where this data is useful.

To create data sources, complete these steps:

1. Select **Control Panel --> Administrative Tools --> Data Sources (ODBC)** and the ODBC Data Source Administrator dialog box appears.

2. The administrator, who creates the system data source, should click the **System DSN** tab. However, the administrator like regular users, who are creating data sources on their local machines, can select the **User DSN** tab.

3. Click **Add**.
4. The Create New Data Source dialog box appears. Use the scroll bar to locate the appropriate driver.

**Note:** Version 5.1 of the ODBC driver is used for example purposes only.

4. Select the SQL Server ODBC Driver in the Create New Data Source dialog box.

5. Click **Finish**.
The Connector/ODBC dialog box appears.

To point the ODBC driver to the server, complete the following steps:

1. Type in the name of the data source. Administrators use into the **Data Source Name** field. For example, type `mysql` for the first database and `tstmdb`, for the second data source. Regular users enter a database name, for example, `tstmdb`.

2. Type an explanation for this data source into the **Description** field. For example, enter `TSTM_Project`.

3. Type the name of the server into the **Server** field. For example, specify `myserver`.

4. Leave the port number for the server that is automatically entered into the **Port** field, for example, `3306`.

5. Type the name of the user into the **User** field. Administrators type in their administrative user name as it is entered on the server. Regular users specify the user name that is entered for them by the administrator who added users to the database.
Note: You cannot use a period (.) or an @ sign when you create a user name for MySQL Server. This means, for example, that you cannot specify an e-mail address as a database user name.

6. Type the password for the user or administrator into the **Password** field.

7. You, as the administrator type `mysql`, the first time you use this section, into the **Database** field. The second time, the administrator like all regular users (who are using this section for the first time and administrators who might be using this for the third time) can specify, for example, `tstmdb`.

8. Click **Test**. If the connection is successful, the Connector/ODBC screen appears with a message stating that the connection was successful.

9. Click **OK**.

10. (Optional) Click **Details** in the MySQL Connector/ODBC dialog box and you can set various types of flags.

11. Click **OK** in the MySQL Connector/ODBC dialog box.
2.6 Administrative Setup

2.6.1 Before You Initialize the Database and Add Users

This section is for administrators who initialize and add users to the database. Use each of the following subsections with Section 2.5 Setting Up ODBC Data Sources on page 10.

2.6.2 Initialize the Database

The following credentials provide one example of the information that you use:

- **Name:** tstmdbadmin
- **User:** <admin_username>
- **Password:** <admin_password>
- **Database:** mysql

Use the following command line to initialize your database:

```
_tstmgr -initialize_database
  [-database <db_name>]
  -driver admin
  -user <sql_root_username>
  [-pass <sql_root_password>]
  -verbose
```
Use the descriptions that are explained in Table 2-3 below to understand the arguments that you specify for this command:

Table 2-3: Command Line Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[database &lt;db_name&gt;]</td>
<td>(Optional) Leave the default tstmdb, or specify this database when new users are added. For more information, see Section 2.7 Client Setup on page 23 and Section 2.6.3 Add Users on page 21.</td>
</tr>
<tr>
<td>driver</td>
<td>Specify the name of the ODBC driver that you use to connect to the SQL Server database in order to create the SAS Ontology Management Studio database.</td>
</tr>
<tr>
<td>initialize_database</td>
<td>Specify the name of the SAS Ontology Management Studio database that is initialized. By default, this database is named tstmdb, unless you specify the optional -database parameter above. In either case, you specify the initialized database when you add users. For more information, see Section 2.6.3 Add Users below. You also specify this argument when you set up your client. For more information, see Section 2.7 Client Setup on page 23.</td>
</tr>
<tr>
<td>pass</td>
<td>&lt;sql_root_username&gt;: Enter the user name of the administrator with SQL Server privileges.</td>
</tr>
<tr>
<td>user</td>
<td>&lt;sql_root_username&gt;: Specify the password for the administrator with access to SQL Server.</td>
</tr>
<tr>
<td>verbose</td>
<td>(Optional) Specify this argument and SAS Ontology Management Studio runs in verbose mode.</td>
</tr>
</tbody>
</table>
2.6.3 Add Users

The following credentials provide one example of the information that you use to add users to your database:

Name: tstmgrdb
User: <admin_username>
Password: <admin_password>
Database: tstmdb (or the name that you specified using the -database argument in Table 2-3 above)

After you configure the databases, project administrators—unless the server administrator also monitors the SAS Ontology Management Studio database—and regular users, are set up on the server. Here you specify both types of permission levels and passwords.

**Note:** This section assumes that the user that you want to add to the SAS Ontology Management Studio database does not currently exist in the system database. This syntax specifies that both a system database account and a SAS Ontology Management Studio user record are created for this user.

The repository administrator is the manager who has the root password (-pass) for the server and who determines the permission levels for all of the developers as this administrator adds them to the project. To add either a project administrator (who automatically has project upload privileges) or a regular user, use the following command line. The user name of the new user is specified as newuser. The user’s password is optional. You can specify the password using the argument user_password-if-any.

Use the following command line to add users to your database:

```
tstmgr.exe -add_user
    -driver <odbc_driver_name>
    -user root
    [-pass root_password_if_any]
    -username newuser
    [-password user_password_if_any]
    -admin|-regular
```
[-can_upload]
[-host host1 -host host2 ...]

Also see Section A.5 *Understanding General Operations* on page 215 for information on how to delete users, change user types, and show a list of users.

**Table 2-4: Command Line Arguments**

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-add_user</td>
<td>Add a user to the database.</td>
</tr>
<tr>
<td>-admin</td>
<td>-admin: Make the user a SAS Ontology Management Studio project administrator.</td>
</tr>
<tr>
<td>-regular</td>
<td>-regular: Make the new user a regular user for whom an administrator can set access privileges.</td>
</tr>
<tr>
<td>-can_upload</td>
<td>Specify -can_upload for a regular user, and this user has permission to upload projects to the server. This developer effectively becomes a project administrator for the projects that she or he uploads. As a project administrator, this user can also change the permission levels of regular users.</td>
</tr>
<tr>
<td>-driver</td>
<td>Specify the name of the ODBC driver that you use to connect to the SAS Ontology Management Studio database.</td>
</tr>
<tr>
<td>-host host1</td>
<td>Specify hosts (either host names or IP addresses). Users can log in only from these locations. If you do not specify either a host name or an IP address, the developer can log in from any machine.</td>
</tr>
<tr>
<td>-host host2</td>
<td></td>
</tr>
<tr>
<td>-pass</td>
<td>Type the password for the repository administrator here.</td>
</tr>
<tr>
<td>-password</td>
<td>Type in the password for the user.</td>
</tr>
<tr>
<td>-user</td>
<td>Type in the name of the administrative user.</td>
</tr>
<tr>
<td>-username</td>
<td>Type in the name of a user as it appears on the server.</td>
</tr>
</tbody>
</table>
2.7 Client Setup

2.7.1 Installing SAS Ontology Management Studio

2.7.1.A Before You Install

This section can be used by users with both administrative and regular user permissions. Before using the following subsections of this section, use Section 2.5 Setting Up ODBC Data Sources on page 10 to set up your data source. Use the following example of credentials unless you have already used this process to set up SAS Content Categorization Collaborative Server databases.

Name: tstmdb
User: <username>
Password: <password>
Database: tstmdb, or specify the name that you specified using the -database selection.
2.7.1.B Install on UNIX

SAS Ontology Management Studio is distributed on UNIX systems as a tar archive. To install the software, use the following commands:

```
gzip -d installKit.tar.gz

tar -xvpf installKit.tar
```

The -d switch on the gzip command decompresses the distribution file (compressed to save space) in preparation for the expansion of the archive tar file. The switches on the tar command extract the contents from the specified tar file, preserving the file and directory permissions of the contents. The actual name of your tar file might vary from that shown in the example above. Additional information on using the gzip and tar commands is available in the UNIX main pages.

2.7.1.C Install on Windows

To install SAS Ontology Management Studio, complete these steps:

1. Double-click SAS_OntManagement_Studio_Setup.exe and the splash page of the installation wizard appears.
The Welcome page appears.
2. Click **Next** and the Choose Install Location page appears.

![Choose Install Location](image)

3. (Optional) Click **Browse** and the Browse For Folder dialog box appears where you can select a new install location.

4. Compare the **Space required** number and the **Space available** numbers to see if there is enough space on your machine to install this program.

5. Click **Install**.
6. The Installation Complete page appears.

7. (Optional) Click **Show Details** to see a list of the downloaded files.

8. Click **Close**.

### 2.7.2 Uninstall on Windows

To uninstall the SAS Ontology Management Studio software on a Microsoft Windows operating system, use the following steps:

1. Select **Start --> Settings --> Control Panel**.
2. Select **Add or Remove Programs**.
3. Select the SAS Ontology Management Studio program.

![Add or Remove Programs dialog box]

4. Click **Remove** to uninstall the SAS Ontology Management Studio program.

**Note:** If you use another operation to uninstall the SAS Ontology Management Studio program, unexpected behaviors could occur.

### 2.8 Connecting to the Database

After the connections to the remote server are set up from the local host, a user can log on from any host that they are set up to use. You require three pieces of information to log into the remote repository using SAS Ontology Management Studio:

- the data source name
- your username
- your password

For more information, see Section 2.7 *Client Setup* on page 23 and Section 3.15.1 *Use the Repository Login Dialog Box* on page 98.
2.9 Understanding the Cached Project

A copy of the project that you are working on is automatically saved to your local machine and contains your local changes. It is stored in the Cache folder that is automatically created by SAS Ontology Management Studio and stored in, for example, the following location:

C:\Program Files\SAS_Institute\SAS Ontology Management Studio

Use the Preferences dialog box to set the cache selection to binary format for large projects. For more information, see Section 3.8 Preferences Dialog Box on page 72.
3 Using the Interface

- Your First Look at the SAS Ontology Management Studio User Interface
- Understanding the Interface Components
- Classes Tab
- Slots Tab
- Instances Tab
- Hierarchy Tab
- Queries Tab
- Preferences Dialog Box
- Importing and Exporting Projects
- User Management
- Revert Class Wizard
- Export and Import Instances Wizard
- Uploading Wizards
- Reset Repository
- Miscellaneous Dialog Boxes
3.1 Your First Look at the SAS Ontology Management Studio User Interface

After you have installed SAS Ontology Management Studio select **Start --> All Programs --> SAS Ontology Management Studio** to see the following Welcome window:

*Display 3-1 Welcome window*

The user interface remains blank until you perform the following operations:

1. Select **File --> Connect to DB** to connect to the database. The Repository Login dialog box appears.

2. Type the name of the repository into the **Repository** field.
3. Type your user name into the **User name** field.
4. Type your password into the **Password** field.
5. (Optional) Click the **Remember** dialog box so that you do not need to re-enter this information each time you access the database.
6. Click **OK** and the Open Project dialog box appears.

![Open Project Dialog Box](image)

7. Click **New** and New Project dialog box appears.

![New Project Dialog Box](image)

8. Type the name of the new project into the **Project name** field.
9. Click **OK**.

### 3.2 Understanding the Interface Components

The components of the main window are listed from top to bottom as they appear in the SAS Ontology Management Studio user interface.

**Program and Project title bar**

use with the following components:

**Program**  
specifies SAS Ontology Management Studio

**Project name**  
appears in the Program and Project title bar after you create a new project

**User Name**  
specifies the name that you use to connect to the repository

**Menu bar**  
contains the **File**, **Edit**, **Repository**, **View**, and **Help** menus
Standard toolbar
contains the icons that correspond to some of the selections in the Menu bar.

Project tabs
contains the Classes, Slots, Instances, Hierarchy, and Queries tabs that are accessible after you create or open a project.

Status bar
provides information about the current project that you are viewing. It is located on the bottom left side of the user interface.

3.2.1 Menu Bar
The SAS Ontology Management Studio menus are located in the menu bar. Many of the menu commands are also available on the standard toolbar.

File
use the following eight commands:

New
name your new project in the New Project dialog box that appears

Open
open an existing project in the Open Project dialog box that appears

Close
exit the existing project

Import
import a SAS Ontology Management Studio project .xml file using the Project Wizard

Export
export your SAS Ontology Management Studio project as an .xml file using the Export Wizard

Connect to DB
connect to the database on the server
Disconnect
disconnect from the server

Exit
close the program

Edit
make changes to your project using standard Windows commands and the following command:

Preferences
set project-wide operations in the Preferences dialog box that appears

Repository
use the following three commands to perform database operations:

Reset
reset the repository and delete all of its information. Confirm this operation in the Confirm Reset dialog box that appears

Maintenance
update the repository with the latest version of your project

User Management
change the password of a user in the Change Password dialog box that appears

View
use the following two commands facilitate project development:

Toolbar
make the toolbar visible or invisible

Status Bar
read text that explains the action that you are taking in the lower left side of the user interface

Help
use the following three commands:

User’s Guide
open the index for the SAS Ontology Management Studio: User’s Guide
3.2.2 Standard Toolbar

The standard toolbar is located below the Menu bar. Some of these commands replicate the operations in the drop-down menus for the menu bar.

To hide or show the standard toolbar, select Toolbar in the View menu. Use these buttons as explained in the table below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>name your new project in the New Project dialog box that appears</td>
</tr>
<tr>
<td>![Folder]</td>
<td>open an existing project in the Open Project dialog box that appears</td>
</tr>
<tr>
<td>![Gear]</td>
<td>set project-wide operations in the Preferences dialog box that appears</td>
</tr>
<tr>
<td>![List]</td>
<td>specify the database to connect to in the Repository Login dialog box that appears</td>
</tr>
<tr>
<td>![List]</td>
<td>disconnect from the database and close the project</td>
</tr>
<tr>
<td>![Left Arrow]</td>
<td>return to the Instance that you selected prior to the current Instance selection</td>
</tr>
<tr>
<td>![Left Arrow]</td>
<td>return to the Instance that you selected before you clicked</td>
</tr>
</tbody>
</table>
3.3 Classes Tab

3.3.1 Before You Use the Classes Tab

Classes store ontological information about Categories, as well as the parent-child relationships between Categories. For example, *Apartment* can be a subclass of *Housing*. After you import your Categories into SAS Content Categorization Studio you can write the rules for your Categories.

The Classes tab is the default setting for SAS Ontology Management Studio. This tab is used to name and define Classes. The metadata for these Classes is defined under the Slots heading in this tab.

Slots filter out unimportant information in a document by identifying the key data, or metadata, that is essential for Class membership. You can also use the Classes tab to set the default user permissions for other developers at the Class and Instance levels.

Display 3-2 Classes tab

The Classes tab has two major sections. These are the ontology and Class Editor sections. For more information, see Section 3.3.2 Ontology Pane below and Section 3.3.3 Class Editor Section on page 40.
3.3.2 Ontology Pane

Use the ontology section of the Classes tab to see and add nodes to the ontology that you are developing. SAS Ontology Management Studio displays the ontology of the basic program that is automatically installed with SAS Ontology Management Studio. You add Classes and subclasses to this ontology as you build your project.

To access the operations in the ontology pane, complete this step:
Right-click on a node in the taxonomy pane.

Display 3-3 Pop-up menu

Use the operations in the pop-up menu, as explained below, to manage your Classes:

**Create Subclass**
create a child Class for parent nodes installed with the program. Create new child Classes for these children and reiteratively continue this process until you have defined the hierarchy that your organization requires.
Delete
remove a created Class or subclass. However, you cannot delete any of the Classes included in your project by default; in other words, Generic, Concept, Concept Grammar, Regex, or Entity. You cannot delete a Class that you created with subclasses. For more information, see Section 3.5.2 Taxonomy Pane on page 56.

Upload to TK240
upload a Class, with its children, to your SAS Content Categorization Studio project

Expand
expand your ontology so that you can see the subclasses of the selected Class

Collapse
collapse the displayed ontology to see only high level nodes

Set Permission
set permission levels for individual users or for groups of users in the Permission Editor dialog box that appears. These permissions differ from those specified in the Default Class Permission field in the Class Editor section of the Classes tab. For more information, see Section 3.15.1 Use the Permission Editor and Set Permission Dialog Boxes on page 115.

3.3.3 Class Editor Section

Use the components of the Class Editor section to edit your Classes:

Class Editor
name this section of the Classes tab.

Update button
click when the button is green. The change to green means that an update is required. The update button is only accessible after you make a change. Use this button, after you make any changes to your project, to update your project and to save these changes to the repository.

Class Name
name the Class that you added in the taxonomy pane
**Author**

see the name that you entered into the **User Name** field of the Repository Login dialog box

**Default Class Permission**

choose the default Class permission setting for all regular users on this project using this drop-down menu.

*Display 3-4 Default Class Permissions drop-down menu*

Select one of the following **Default Class Permissions** selections:

- **Read only**
  
  see this Class and its Instances without making any changes to them

- **Modify existing instances**
  
  read this Class and modify the values of its Instances

- **Add/delete and modify existing instances**
  
  change, add, and delete Instances

- **Add slots and add/delete/modify existing instances**
  
  enables full permissions for Instances. This user can also add Slots to this Class
All enables full permissions for this Class, as well as its Slots and Instances

**Note:** Permissions set at the Class level are exercised according to the limitations, if any, set for each individual Slot. These permissions apply to users who do not have their permission levels reset using the Set Permission dialog box. For more information, see Section 3.15.15 *Use the Permission Editor and Set Permission Dialog Boxes* on page 115.

Continue to use the selections in the **Class Editor** section of the **Classes** tab:

**Abstract check box**

enables you to make this class noninstantiable. In other words, no Instances of this Class can be created. Abstract Classes are useful when, for example, you want to define Slots that should apply to all of the subclasses of the selected Class or limit Instance creation to the subclasses of the selected Class.

**Note:** Use this operation for the Grammar and Regex Concepts that are abstract by definition. The Entity Class is used to specify Classifier Concepts that are abstract only when you define them as such.

**Inactive check box**

enables you to disable testing for this node. When you select this operation and upload this Class to SAS Content Categorization Studio, the Class is set to **Test Disabled**. The **Test Disabled** operation omits the selected Concept or Category from inclusion in the `.mco` or `.concepts` file. For more information, see *SAS Content Categorization Studio: User’s Guide*.

**Description**

enter a description for the Class that you created
Slot buttons

see the following table:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="create" /></td>
<td>create a new Slot in the Add a Slot dialog box that appears. For more information, see Section 3.3.4 Add a Slot Dialog Box on page 45.</td>
</tr>
<tr>
<td><img src="image" alt="remove" /></td>
<td>remove the selected Slot in the Confirm Delete dialog box that appears. For more information, see Section 3.15.24 Confirm Delete Screen on page 127.</td>
</tr>
<tr>
<td><img src="image" alt="change" /></td>
<td>change the information for the Slot in the Edit a Slot dialog box that appears. For more information, see Section 3.15.13 Edit Slot Dialog Box on page 114.</td>
</tr>
<tr>
<td><img src="image" alt="order" /></td>
<td>order your Slots in the Set Slot Order dialog box that appears. For more information, see Section 3.15.18 Use the Set Slot Order Dialog Box on page 120.</td>
</tr>
</tbody>
</table>

To the left of these buttons see the Slots section and its headings:

**Slots section**

enter Slots for the selected Class. The subheadings under this heading correspond directly to the entries that you make in the Add a Slot dialog box when you create your Slots:

**Name**

automatically enters the name you typed into the Slot Name field in the Add a Slot dialog box.

**Type**

automatically enters the value type that you entered into the Value Type field in the Add a Slot dialog box. For more information, see Section 3.3.4 Add a Slot Dialog Box on page 45.
Inherited

automatically enters \textbf{Y} (Yes) or \textbf{N} (No). \textbf{Y} means that the Slot is inherited and that it has the same attributes in both parent and child Classes. Alternatively, \textbf{N} means that this Slot is not inherited.

A Slot might not be inherited for one of the following reasons:

- This Slot was defined within this Class.

- The Class that is constrained by this Slot was added under the \textbf{Domain} heading in the \textbf{Slots} tab. Although the Slot is not inherited, this Slot also constrains this Class and the subclasses of the Class inherit this Slot.

- If a Slot has a value type of \textbf{Integer} in the parent Class and a value type \textbf{String} in a subclass, it is not an inherited Slot.
3.3.4 Add a Slot Dialog Box

Use the Add a Slot dialog box to add one or more Slots to a Class. This dialog box contains the same components as the Slot Editor section of the Slots tab.

Click to open the Add a Slot dialog box from the Classes tab.

Display 3-5 Add A Slot dialog box

The fields in the Add a Slot dialog box are the same as those found in the Slot Editor section of the Slots tab. For more information, see Section 3.4.4 Slot Editor Section on page 49.
3.4 Slots Tab

3.4.1 Before You Use the Slots Tab

Slots are metadata attributes that are assigned to Classes. The Slots control the types of information that are used to define instantiations of the Classes. In other words, Slots define the metadata that is the data on the information for each of your Classes.

For example, by defining the price, make, and model, Slots for the Class *Cars* you define the types of metadata that determine the types of individual objects that form the Class *Cars*.

Slots differentiate ontology management from taxonomy management. Slots define the data that instantiates each Instance as a member of a Class.

To open the **Slots** tab, select **Slots** in the **Classes** tab.

*Display 3-6 Slots tab*
Until you define one or more Slots using the Create Slot button in the Classes tab, there are no operable fields in this tab. For more information, see Section 3.3.4 Add a Slot Dialog Box on page 45.

Slots are automatically propagated from parent Classes to their subclasses, or children. Slots that are inherited are specified with a Y in the Class Editor section of the Classes tab. For more information, see Section 3.3.3 Class Editor Section on page 40.

3.4.2 Understanding Slot Types

There are three types of Slots in SAS Ontology Management Studio ontology pane:

- **TK240 parent**: This is the default Slot provided with SAS Ontology Management Studio that cannot be edited or deleted. This Slot is used to import a correctly ordered ontology of Categories into SAS Content Categorization Studio. By default the TK240 parent Slot is included in each SAS Ontology Management Studio project. This Slot cannot be edited and applies only to Category subclasses.

- **String**: All Category Classes should contain one Slot with the Value Type: String. This Slot provides the name of the Category when it is uploaded to SAS Content Categorization Studio. All Entity Classes (Concepts) contain a Slot where type = string. This is not used as a match string when uploaded to SAS Content Categorization Studio.

- **User added Slots**: These Slots can be edited.
3.4.3 Taxonomy Pane

Use the taxonomy pane to see all of the defined Slots for your project.

Display 3-7 Taxonomy pane

Right-click on a Slot and use the pop-up menu selections to manage your Classes:

Delete

remove any Slot with the exception of TK240 parent.

Set Permission

set user permission levels in the Permission Editor dialog box that appears. These settings override those that are specified in the Default Class Permission field in the Class Editor section in the Classes tab. For more information, see Section 3.3.3 Class Editor Section on page 40.
3.4.4 Slot Editor Section

Use the **Slot Editor** section of the **Slots** tab to edit your Slots. The **Slot Editor** section and the Edit Slot dialog box are identical. They share the same operations. Editable information for a selected Slot appears in the respective fields within the **Slot Editor** section.

**Note:** Any change to an inherited Slot, affects the Classes whose members include this Slot is a member of.

Use the components of the **Slot Editor** section as explained below:

- **Update button**
  save any changes that you make to your Slot

- **Slot Name**
  change the selected Slot name

- **Author**
  automatically entered from the information in the **User Name** field in the Repository Login dialog box.
**Default Slot Permission:**

use the drop-down menu to set the default level of permissions for all users accessing the **Slots** tab. This permission level applies to users who are not administrators and who do not have their permission levels individually reset using the Set Permission dialog box.

*Display 3-8 Default permissions*

![SAS Ontology Management Studio](image)

**Read only (default setting)**

enables regular users to read, but not to make any changes to, this Slot.

**Modify instance slot value**

read the project and modify any existing Slot values for Instances in the **Instance Editor** section of the **Instances** tab

**All**

modify this Slot and its Instances, and set a default permission level for this Slot
**Note:** Permissions set at the Slot level are exercised according to any limitations that are set for the Class. Both levels of permissions are overridden by any permission level set for an individual or group using the Set Permission dialog box.

**Value Type**

determine the kind of data that this metadata locates in Instances of the selected Class. The selection that you choose for the **Value Type** field determines the selections that are available using the Add a Constraint dialog box. For more information, see Section 3.15.10 *Use the Add a Constraint Dialog Box* on page 107.

*Display 3-9 Value types*

Choose one of the following selections:

- **Integer**
  
  whole numbers, for example, 7, 121, and 52.
Float
   numbers with a floating decimal point, for example, 4.55, 6.3, and 11.6.

String
   a set of characters, for example, fiscal, green, or oil-based

Boolean
   True or False

Class ID
   define a relationship between an Instance and a Class, using the specified field in the Instances tab. You can select a Class to constrain this Slot as the Default value, or choose to select multiple Classes as candidates.

Slot ID
   define a relationship between an Instance and a Slot, using the specified field in the Instances tab. You can select a Slot to further constrain this Slot as its Default value, or choose to select multiple Classes as candidate values for this Slot.

Instance Of
   refers to another Class in the project. You can define another Class as the Default, Candidate, or as the Allowed Class.

Description
   describe the metadata that you are defining with this Slot

Constraints
   limit your Slot values using these selections:
Add, Delete, and Edit buttons

see the following table:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add" /></td>
<td>opens the Add a Constraint dialog box. where you can specify the new Constraint. For more information, see Section 3.15.10 Use the Add a Constraint Dialog Box on page 107.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>remove the selected Constraint and the Confirm Delete dialog box appears. Select a Class that is listed under the Domain heading to make this Remove button accessible. For more information, see Section 3.15.24 Confirm Delete Screen on page 127.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>edit the selected constraint</td>
</tr>
</tbody>
</table>

For more information about the constraint values and how to use them, see Section 5.4.1 Understanding Value Types and Constraints on page 164.

Constraint heading

click to reorder your Constraints alphabetically

Value heading

click to reorder your Constraints according to their values

Domain

display Class membership for the selected Slot when the Classes that the Slot is assigned do not have a parent-child relationship

Use the following buttons as explained in the table below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select Items" /></td>
<td>open the Select Items dialog box. For more information, see Section 3.15.16 Use the Select Items Dialog Box on page 118.</td>
</tr>
<tr>
<td><img src="image" alt="Remove Class" /></td>
<td>remove the selected Class</td>
</tr>
</tbody>
</table>
3.5 Instances Tab

3.5.1 Before You Use the Instances Tab

The Instances tab enables you to define instantiations of your Classes by filling in the metadata values that you defined by creating Slots. These instantiations are known as Instances. For example, if you defined the Class Car, you could instantiate a 2009 red Toyota Prius using the following Slots:

- Year: specify an integer value of 2011
- Color: enter a string value of red
- Make: specify a string value of Toyota
- Model: enter a string value of Prius

**Note:** If you plan to upload Instances of entity Classes to SAS Content Categorization Studio, you should not use commas (,) when you specify values for the Slots that constrain these Classes. Instead use a backslash followed by a lowercase c (\c). For example, type red exterior\cwhite interior.
Display 3-10 Instances tab
3.5.2 Taxonomy Pane

Use the taxonomy pane of the **Instances** tab to see your Classes. You can also use the pop-up menu selections that are available when you right-click on the following nodes:

**THING**

right-click on this node and select **Update instances of all classes** from the pop-up menu that appears. This operation is specific to this node.

*Display 3-11 Pop-up menu selections*

**Generic Class, Concept Class, Concept Regex, Concept Grammar, and the Entity Class**

right-click on these node sand select any of the operations that appear in the pop-up menu
Use the pop-up menu selections as described below:

**Upload to SAS Content Categorization Studio**

use the Class Uploading Wizard that appears to perform this operation. For more information, see Section 3.13 *Uploading Wizards* on page 91.

**Update Instances**

update the Instances in your project when your project is out-of-date with the project on the repository. The **all classes** selection that is available for the **THING** node only updates all of the Instances for all of your Classes.
**Consistency Check**

check the values that you entered for the Slots in your project. If there are no errors, the Prompt screen appears.

**Maintenance**

clean up, fill in, and modify Slot values using the Class Maintenance Wizard

**Revert Class To Older**

return to an earlier version of this Class using the Revert Class Wizard

**Export Instance**

export the Instances of the selected Class as either an .xml or a .csv file. For more information, see Section 3.12.2 Export Instances of Class Wizard on page 88.

**Import Instances**

import Instances in either the .xml or a .csv file. For more information, see Section 3.9.3 Import Project Wizard on page 79.

**Expand**

see all of the subnodes

**Collapse**

hide the subnodes so that you see only the parent node

**Set Permission**

specify new permission level in the Permission Editor dialog box that appears. For more information, see Section 3.15.15 Use the Permission Editor and Set Permission Dialog Boxes on page 115.
3.5.3 Instances Section

Use the **Instances** section to see the Instances that you added to your Class. The components in the **Instances** section also help you to manage the Instances that you defined.

*Display 3-13 Instances tab*

Use the following components of the **Instances** section of the **Instances** tab:

- **blank field**
  - type the name of the Instance that you want to find

- **Instances pane**
  - display the Instances, whether matched from the search criteria that you specify, or those with the selected Slot
Use the buttons explained in the table below to perform searches and to navigate through the search results:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>click</strong></td>
<td>click the search button after you enter a search term. SAS Ontology Management Studio displays the located matches, only, in the Instance display pane below. The first of the matched Instances is also be displayed in the <strong>Instance Editor</strong> section.</td>
</tr>
<tr>
<td><strong>see all</strong></td>
<td>see all of the Instances, if you click first.</td>
</tr>
<tr>
<td><strong>Note</strong>: All Instances include those with name changes that originally had the searched name.</td>
<td></td>
</tr>
<tr>
<td><strong>Case Sensitive radio button</strong></td>
<td>perform a search that locates only the text, in the upper- and lowercase letters that you enter</td>
</tr>
<tr>
<td><strong>Case Insensitive button</strong></td>
<td>perform a search that locates the text, regardless of the upper- and lowercase letters that you enter</td>
</tr>
<tr>
<td></td>
<td>add a new Instance to the Class</td>
</tr>
<tr>
<td><strong>delete</strong></td>
<td>delete the selected Instance</td>
</tr>
<tr>
<td></td>
<td>deletes all Instances in the pane below. A Confirm Delete dialog box appears asking you to verify this choice. For more information, see Section 3.15.24 <strong>Confirm Delete Screen</strong> on page 127.</td>
</tr>
<tr>
<td></td>
<td>select one of the following operations from the drop-down menu that appears:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Set Display Slot</strong>: Open the Set Display Slot dialog box that you can use to change the Slot name. For more information, see Section 3.15.17 <strong>Use the Set Display Slot Dialog Box</strong> on page 119.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Sort (A to Z)</strong>: Reorder the Instances alphabetically</td>
</tr>
<tr>
<td></td>
<td>- <strong>Sort (Z to A)</strong>: Change the ordering of the Instances to appear in reverse alphabetical order.</td>
</tr>
</tbody>
</table>
3.5.4 Instance Editor Section

Use the Instance Editor section of the Instances tab to specify Slot values for Instances of your Class.

Right-click on and the Instance information fields are displayed.
See the following fields:

**Created by**
the name of the person who created the Instance

**Creation date**
date the Instance was created

**Modified by**
name of the last user to change this Instance

**Modification date**
the last date that a change was made

**Instance Status**

Click to change the default status from **Active**
Inactive deleted
delete the Instance from the current project

Inactive disabled
disable and inactivate the selected Instance

Inactive proposed
mark as inactive and a proposed addition to the project

Inactive rejected
mark as inactive and rejected from the current project

**Editing buttons**
see the following table:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Arrow Up" /></td>
<td>save any changes to your project. This arrow turns green when you make a change that should be saved.</td>
</tr>
<tr>
<td><img src="image" alt="Create" /></td>
<td>the Create a Value dialog box appears. For more information, see Section 3.15.19 Use the Create a Value Dialog Box on page 122.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>removes the information entered into this Slot field</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>opens the Edit Value dialog box. For more information, see Section 3.15.14 Use the Edit Value Dialog Box on page 115.</td>
</tr>
<tr>
<td><img src="image" alt="Resize" /></td>
<td>enlarges the field and changes to</td>
</tr>
</tbody>
</table>

**Tip:** If you click on an Instance that is related to another Instance in the *Instance Editor* section of the Instances tab, a new *Instance Editor* dialog box appears. This
dialog box displays the information for the related Instance that you selected.

3.6 Hierarchy Tab

3.6.1 Before You Use the Hierarchy Tab

Use the Hierarchy tab to define, and then to see, an ontology of relationships between Instances that share a common Slot. Instances with common Slots are constrained by the Hierarchy Element Constraint. This selection is also useful when you want to limit redundancy in your SAS Ontology Management Studio project by reusing information defined specifically for another Class.

Display 3-15 Hierarchy tab
3.6.2 Taxonomy Pane

The taxonomy pane displays the Slots defined by any of the following three values:

- **Value Type**: Instance of
- **Constraint**: Allowed Class. Alternatively, you can specify Multiple Cardinality to create a multi-tiered ontology.
- **Constraint**: Hierarchy Element

Click on any node in the taxonomy pane to see the Instances displayed as nodes. If you click the TK240 parent node, the taxonomy is displayed.

There are two drop-down menu selections that are unavailable when you right-click on the TK240 parent Slot, but available for the other Slots, in the taxonomy pane of the Hierarchy tab.

**Delete**

remove a Slot

**Set Permission**

open the Permission Editor dialog box where you can set the permissions for this Slot. For more information, see Section 3.15.15 *Use the Permission Editor and Set Permission Dialog Boxes* on page 115.
3.6.3 Instances Section

Use the **Instances** section to see the taxonomy, if you select the **TK240 parent node**. Alternatively, see the related Instances, if you select another node in the pane to the left of this section.

Use the table below to understand how to use the buttons in this section of the **Instances** tab:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>invert the taxonomy in order to see the relationships between various Instances</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>scroll through your pages of Instances. The figure to the left of these arrows displays the page number that you are currently viewing.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>go to the first page of Instances</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>return to the Instances page that you last saw</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>go to the next page of Instances</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>go to the last page of Instances</td>
</tr>
</tbody>
</table>
3.6.4 Instances Editor Section

For information about this section, see Section 3.5.4 *Instance Editor Section* on page 61.

3.7 Queries Tab

3.7.1 Before You Use the Queries Tab

Use the **Queries** tab to search, locate, and change, if necessary, the information for Slots and Classes. The **Queries** tab enables you to configure your queries.

*Display 3-17 Queries tab*
3.7.2 Query Section

Use the following components of the **Query** section of the **Queries** tab:

**Check box**

- limit your find results to the selected row

**Class**

- click `+` to open the Select Items dialog box where you can choose your Classes. For more information, see Section 3.15.16 *Use the Select Items Dialog Box* on page 118.

- alternatively, click `−` to delete a Class that you added using `+`.

**Slot**

- click `+` to open the Select Items dialog box where you can choose your Slot. For more information, see Section 3.15.16 *Use the Select Items Dialog Box* on page 118.

- alternatively, click `−` to delete a Slot that you added using `+`.

**Condition**

- specify the relationship between the letters that you type into the **String** field and the selected Slot:

  **Is**
  
  - the entered string is the totality of a Slot value entry

  **Is not**
  
  - the entered string does not represent the Instance

  **Begins with**
  
  - the first letters of the Slot value

  **Ends with**
  
  - the last letters of the Slot value
Contains
   is found within

Does not contain
   is not found within

For the following two values, no entry is necessary in the Slot field in this Queries tab or in the Replace dialog box. For more information, see Section 3.15.8 Use the Replace Dialog Box on page 105.

Is NULL
   no value, or False, in Boolean terminology

Is Not NULL
   has a value, or is True, in Boolean terminology

(String)
   type in the list of alpha characters that you are searching in this field

Case Sensitive
   perform case-sensitive queries when you click this check box

More
   add one row (at a time) of Class, Slot, Condition, and String fields

Fewer
   delete a single row (at a time) of added Class, Slot, Condition, and String fields

Clear
   return to the Queries tab to its default state

Use the following two selections when you have multiple rows of Class, Slot, Condition, and String fields:

Match All
   return all Instances containing matches for all of the selected rows of the combination Class, Slot, Condition, and String fields

Match Any
   return all of the Instances that contain matches for any of the selected rows
Replace
type the new term into the Replace dialog box that appears. For more information, see Section 3.15.8 *Use the Replace Dialog Box* on page 105. 

*Display 3-1 Condition drop-down menu*

3.7.3 Search Results Section

Use the **Search Results** section of the **Queries** tab to see, remove, and to sort the results that are returned after you click **Find**.

Use the components of this section as explained below:

- **numbers**
  display the number of results shown in the pane below and the total number of results returned for this project
results pane

see the search results and use the buttons explained in the table below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Delete button]</td>
<td>delete the selected Instance</td>
</tr>
<tr>
<td>![Clear button]</td>
<td>delete all of the Instances</td>
</tr>
<tr>
<td>![Sort dropdown]</td>
<td>select one of the following operations from the drop-down menu that appears:</td>
</tr>
<tr>
<td>![Sort dropdown]</td>
<td>- <strong>Sort (A to Z)</strong>: Sort the found Instances alphabetically</td>
</tr>
<tr>
<td>![Sort dropdown]</td>
<td>- <strong>Sort (Z to A)</strong>: Order the located Instances in reverse alphabetical order</td>
</tr>
<tr>
<td>![Sort dropdown]</td>
<td><strong>Note</strong>: This ordering is case-insensitive.</td>
</tr>
<tr>
<td>![Sort dropdown]</td>
<td>- <strong>Advanced</strong>: access case-sensitive sorting operations in the Sort Setting dialog box that appears. For more information, see Section 3.15.9 <em>Use the Sort Setting Dialog Box</em> on page 106.</td>
</tr>
</tbody>
</table>
3.8 Preferences Dialog Box

Use the Preferences dialog boxes to set the automatic operations that apply across your SAS Ontology Management Studio project.

To open and use the Preferences dialog box, complete these steps:

1. Select Edit --> Preferences and the Preferences dialog box appears.

2. (Optional) Click Always reconnect on ODBC timeout and SAS Ontology Management Studio automatically reconnects to the server.

3. (Optional) Click Begin recording debugging info in log file after restarting and SAS Ontology Management Studio writes a log file for
debugging purposes. If you select this operation, click in the Log file field and the Log file Save to dialog box appears.

4. Click in the Save in field and select the location of your file.

5. Type the name of the debugging file into the File name field.

6. Click Save in the Log file Save to dialog box.

7. Leave Save cache file in binary format, which is useful for large projects (default selection) selected in the Preferences dialog box. When you choose this operation, the local cache is stored in a proprietary binary file, instead of an .xml file. The binary file increases the speed that large projects can be opened and closed and it also decreases the memory requirements of the application.

8. (Optional) Click Use an alternate character to separate lists of slot values in imported and exported CSV files. Use this selection when you export or import Instances that are defined by a Slot that is constrained by Multiple Cardinality, into an Excel spreadsheet.
Excel does not recognize tab characters in the middle of a cell.) Click this check box and type in the separator character of your choice.

For example, if you select the semicolon ( ; ), this character appears between the multiple values in a single cell within an Excel spreadsheet.

![Excel spreadsheet example](image)

**Notes:** It is not necessary to specify an alternative character if you are opening your .csv files in Notepad or in WordPad. Commas ( , ) can only be used as separator values within .csv files for entity Classes. They cannot be used as separators in Slot values that are uploaded to SAS Content Categorization Studio.

However, if you specify a semicolon ( ; ) as part of one or more Slot values and also select a semicolon as the separator character, each semicolon is replaced with a backslash followed by a semicolon ( \; ). Each backslash character is replaced by two backslash characters ( \\ ). Alternatively, if you choose another character as a
separator character, only the backslash characters are replaced by
two backslash characters.

9. Click **OK**.

10. Select **Edit --> Preferences**.

11. Click the **Editing** icon in the left pane of the Preferences dialog box to
open the Preferences - Editing dialog box where you can choose your
automatic editing selections.

12. (Optional) Select **Allow editing inherited slots in sub-classes** to
edit Slots that are inherited within subclasses as well as in the Class that
the subclasses are descended from. If you choose to deselect this check
box, is disabled for subclasses. For more information, see Section
3.4.4 **Slot Editor Section** on page 49.
13. Leave the default check box, **Prompt for update when leaving window with unsaved data**, selected. If you deselect this setting, the Save confirmation alert dialog box appears.

![Save confirmation alert](image)

14. Click **Yes**.

If you deselect the **Prompt for update when leaving window with unsaved data** check box, you can exit the various SAS Ontology Management Studio tabs without saving your changes. Unless you are the sole developer of this project, you should keep this default setting.

15. Select **Delete dependencies when instances are deleted** when you choose to delete an Instance in the **Instances**, **Hierarchy**, or **Queries** tab that has a dependent Instance. A Warning dialog box appears. This dialog box displays the related Instances.

![Warning](image)

For more information, see Section 3.15.25 *Warning Dialog Boxes* on page 128.
3.9 Importing and Exporting Projects

3.9.1 Understanding Import and Export Operations

Use the import and export project operations to make copies of your project. These copies, in either .xml or binary format, are used to open a SAS Ontology Management Studio project that is located in a different database than the repository that you are currently using.

You can also use this operation when you import a SAS Ontology Management Studio project that was revised by a third-party application, or you want to join small SAS Ontology Management Studio projects together. You can also use the export-import process to move a project from one repository into another. This operation enables a developer, who would otherwise lack access to your project, to import a copy of the project into their repository.

**Note:** The exported files cannot be used with SAS Content Categorization Studio. For more information, see Chapter 6.

3.9.2 Use the Export Project Wizard

Use the Export Project Wizard to move a copy of a project from the database or an open project to another location. The first step explains the different access operations, depending on the outcome that you are seeking.

To export a project from the database, complete these steps:

1. Select **File --> Open**.

   (Alternatively) To export an open project, select **File --> Export** and go to Step 4. on page 78.
2. Select a project in the Open Project dialog box that appears:

3. Click **Export**. The Export Project Wizard Step 1 of 2: Specify a location for exported project dialog box appears.

4. (Optional) Select a **File Type**. By default **XML** is selected. Click the **Binary** radio button to export a large project as a binary file.

5. Click in the **Where to store exported project file?** field and the **Save As** dialog box appears. Use this dialog box to locate the folder
where the exported project is stored. For more information, see Section 3.15.22  Save As Dialog Box on page 125.

6. Click **Next** and the Export Project Wizard Step 2 of 2: Success dialog box appears.

![Image of Export Project Wizard Step 2 of 2: Success dialog box]

7. Click **Finish**.

### 3.9.3 Import Project Wizard

To import a project from the database, complete these steps:

1. Select **File --> Open**.

2. (Alternatively) To import an open project, select **File --> Import** and the Open Project dialog box appears.

![Image of Open Project dialog box]
3. Select a project and click **Import**. The Import Project Wizard Step 1 of 3: Locate a project file dialog box appears.

![](image)

4. Select a **File Type**. By default **XML** is selected. Click the **Binary** radio button to export a large project as a binary file.

5. Click **Open** in the **Project file** field and the Open dialog box appears. Select a project to import. For more information, see Section 3.15.23 *Open Dialog Box* on page 126.
6. Click **Open**.

7. See the taxonomy of the new project displayed in the Import Project Wizard Step 2 of 3: Preview Project dialog box that appears.

8. Click **Next** and the Import Project Wizard Step 3 of 3: Success dialog box appears:

9. Click **Finish**.
3.10 User Management

3.10.1 Before You Use the User Management Dialog Box

You, as the project administrator, can use the User Management dialog box to change the passwords for regular users or to define a group of users that is a list of people who have the same level of permissions.

To open the User Management dialog box, complete this step:

Select **Repository --> User Management** and the User Management dialog box appears.

*Display 3-18 User Management dialog box*
3.10.2 User Management - Users Tab

To use the **Users** tab in the User Management dialog box, complete these steps:

1. Click the **Name** heading to reorder the list of names from Z-A, or from A-Z.

2. Click the **Privilege** heading to reorder the list of names by project access permission levels.

3. Click **New** to specify a new user and enter their password in the New User dialog box that appears. For more information, see Section 3.15.6 *Use the New User Dialog Box* on page 103.

4. Click **Password** to change the password for the selected user in the Change Password dialog box that appears. For more information, see Section 3.15.7 *Use the Change Password Dialog Box* on page 104.

5. Click **Delete** to remove the selected user from the project.
3.10.3 User Management - Groups Tab

You, as the project administrator, use the User Management - Groups dialog box to compile one or more lists of users who have the same permission level. By default all users with the Administrator permission level are defined as the Administrators group.

1. To open the Groups tab, while you are using the Users tab, click Groups.

2. Click the Name heading to record the list of names from Z-A, or from A-Z.

3. Click the Privilege heading to record the list of names by project access permission levels.

4. Click the Description heading to record the list of names by project access permission levels.

5. Click Properties and define the members of your groups in the Group Properties dialog box that appears. For more information, see Section 3.10.3.B Group Properties Dialog box on page 86.

6. Click New and define the members of your groups in the Group Properties dialog box that appears. For more information, see Section 3.10.3.A New Group Dialog Box on page 85.

7. Click Delete to remove a selected user from the list.
3.10.3. A New Group Dialog Box

Use the New Group dialog box to define a new group of users and their permission level.

To open and use the New Group dialog box, complete these steps:

1. Click **New** in the **Groups** tab of the User Management dialog box.

![New Group dialog box](image)

2. Type the name of the new group into the **Group name** field.

3. Type an explanation of this type of user into the **Description** field.

4. Click **Administrator privilege** if your new group is comprised of project administrators.

5. Click **+** to open the Select Users dialog box.

![Select Users dialog box](image)
6. Select a user.
7. Click **OK**.
8. Select a user in the Members field and click **to remove this member from the group.**
9. Click **OK** and see this list under the **Members** title.

### 3.10.3.B Group Properties Dialog box

Use the Group Properties dialog box to change the information and users in any of the field:

Display 3-19 Group Properties dialog box

For more information about how to use this dialog box, see Section 3.10.3.A New Group Dialog Box on page 85.
3.11 Revert Class Wizard

Use the Revert Class Wizard to return the Class that you select, using the **Instances** tab, to an earlier definition.

To open and use the Revert Class Wizard, complete these steps:

1. Right-click on a Class in the taxonomy pane of the **Instances** tab.

2. Select the **Revert Class To Older** operation in the pop-up menu that appears. The Revert Class Wizard Step 1 of 2 dialog box appears.

   a. Click **or** to locate an older version.

   b. Click **Next** and the Revert Class Wizard: Step 2 of 2 dialog box appears.

   c. Click **Finish**.
3.12 Export and Import Instances Wizard

3.12.1 Before You Use the Export and Import Instances Wizard

Export your Instances for the purposes of modifying, deleting, or adding to your Instances using either a script or a third-party application. You can choose to export and import .xml or .csv (comma separated value) files. The examples in each of these sections apply to .xml only.

You can only import Instances into the same Class and project that you export them from.

3.12.2 Export Instances of Class Wizard

The Export Class Wizard enables you to export all of the Instances of a selected Class. You can choose to export the Instances as either an XML or a CSV file that opens in a Microsoft Excel spreadsheet file.

To open and use the Export Instances of Class wizard, complete these steps:

1. Right-click on a Class in the taxonomy pane of the Instances tab and select Export Instances from the pop-up menu that appears. The Export Instances of class - Step 1: Select file dialog box appears.

2. Leave XML (the default setting) selected.

3. (Optional) Click CSV to export the Instances of the Class that you have selected as a .csv file.
4. Click in the File path field and the Save dialog box appears. Select a folder and save the output file. For more information, see Section 3.15.21 Use the Save Dialog Box on page 124.

After you set the information to use to save your file in the Save dialog box, the name of this file and its path appear in the Export Instances of class dialog box.

5. Click Next and the Export Instances of class - Step 2: Exporting instances dialog box appears

6. Click Finish.
3.12.3 Import Instances of Class Wizard

The Import Class Wizard enables you to import either an .xml or a .csv file of Instances into a selected Class.

To import, open and use the Import Instances of Class wizard, complete these steps:

1. Right-click on a Class in the ontology pane of the **Instances** tab and select **Import Instances** from the pop-up menu that appears.
   
   The Import Instances of class Step 1 - Select file dialog box appears.

2. Use Step 3. through Step 5. on page 89. However, use the Open dialog box instead of the Save dialog box in Step 4. to locate the file to import. For more information, see Section 3.15.23  *Open Dialog Box* on page 126.

3. Click **Next**.

4. The Import Instances of class - Step 2: Importing instances dialog box appears.

5. Click **Finish**.
3.13 Uploading Wizards

3.13.1 Category Class Uploading Wizard

Upload the entire taxonomy of Categories that you created in SAS Ontology Management Studio to SAS Content Categorization Studio.

To upload your Category taxonomy, complete these steps:

1. Right-click on the Category Class node, in the ontology pane of the Classes tab and select Upload to SAS Content Categorization in the pop-up menu. The Category Uploading Wizard - Step 1 of 2: Specify a slot for category name appears.

2. Click in the Language field and select a language, if you purchased more than one language.

3. Click in the Slot for category name field and the Select a Slot dialog box appears.

4. Select a Slot, for example, Category_Name.

5. Click OK. For more information, see Section 3.15.12 Use the Select a Slot Dialog Box on page 113.
6. (For UTF-8 languages only) Click  in the **Slot for category display name** field. See Step 3. on page 91.

7. Click **Next** and the Category Uploading Wizard - Step 2 of 2: Success dialog box appears.

![Category Class Uploading Wizard](image)

8. Click **Finish**.

9. (Optional) Begin working with the uploaded taxonomy of Category Classes in SAS Content Categorization Studio.

### 3.13.2 Class Uploading Wizard

To open and use the Entity Class Uploading Wizard, complete these steps:

1. Right-click on the **Category Class** node, in the ontology pane of the **Classes** tab and select **Upload to SAS Content Categorization** from the pop-up menu that appears.
The Class Uploading Wizard - Step 1 of 4: Set concept information dialog box appears.

2. (Optional) Click to select a Language if you have purchased more than one language. The default selection is English.

3. (Optional) If you are building a project with a language that uses UTF-8 encoding, type the name that SAS Content Categorization Studio uses for the Concept name into the Name (ASCII characters only) field.

4. Click Next.

The Class Uploading Wizard - Step 2 of 4: Specify fields mapping dialog box appears.

5. Click to choose a selection in the Target fields drop-down menu that appears.
- (Default, and recommended, selection) **Match Field**: Specify the strings that are a literal match in an input document.
- **Info Field**: Specify the field that provides information about the entity.
- **TGIF Field**: Specify that input documents with a match on the Boolean rule that evaluates to **True** are a match for this Concept.
- **TGUNLESS Field**: Specify that input documents with a match on the Boolean rule that evaluates to **False** are a match for this Concept.

6. Use the buttons as explained in the table below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Load all of the Slots into the pane" /></td>
<td>load all of the Slots into the pane below the Slot heading</td>
</tr>
<tr>
<td><img src="image" alt="Remove all of the automatically loaded Slots" /></td>
<td>remove all of the automatically loaded Slots</td>
</tr>
<tr>
<td><img src="image" alt="Add Slots using the Select a Slot dialog box" /></td>
<td>add Slots using the Select a Slot dialog box</td>
</tr>
<tr>
<td><img src="image" alt="Delete the added Slot" /></td>
<td>delete the added Slot</td>
</tr>
<tr>
<td><img src="image" alt="Move the Slot up" /></td>
<td>move the Slot up</td>
</tr>
<tr>
<td><img src="image" alt="Move the Slot down" /></td>
<td>move the Slot down</td>
</tr>
</tbody>
</table>
7. Use the headings below these buttons as explained below:
   - **Slot** heading: The Slot name is listed here.
   - **Type**: This is the **Value Type** that you specified in the **Slots** tab.
   - **Inherited**: Underneath this heading, you will see a **Y** (yes) or an **N** (no). These abbreviations specify whether or not this Slot is inherited from another Class in your ontology.

8. Click **Next** and the Class Uploading Wizard - Step 3 of 4: Preview appears. By default, **Text view** is selected.

   ![Class Uploading Wizard](image)

   **Note:** The pipe character (|) is used as a separator character, similar to a space ( ) or comma (,) character, in the returned_information string for Classifier Concept definitions.
9. (Optional) Click **List view** to see these matches specified under the headings for the Slots.

![Class Uploading Wizard](image)

10. (Optional) Click **Match Field**, or any of the other Slot heading to rearrange these fields numerically and then alphabetically.

11. Click **Next** and the Class Uploading Wizard - Step 4 of 4: Success appears.

![Class Uploading Wizard](image)

12. Click **Finish**.
3.14 Reset Repository

Use the reset repository command to remove all of the projects stored on your repository. When you select this operation you choose to delete all of the projects in the database. Teragram recommends that you export your SAS Ontology Management Studio projects to another repository before using this command. See Section 3.9.2 *Use the Export Project Wizard* on page 77.

1. Go to Repository --> Reset.
2. The Confirm Reset dialog box appears:

![Confirm Reset Dialog Box]

3. If you select the Yes, all of the projects in the repository are deleted. The SAS Ontology Management Studio screen appears.

![SAS Ontology Management Studio Screen]
3.15 Miscellaneous Dialog Boxes

3.15.1 Use the Repository Login Dialog Box

Use the Repository Login dialog box to access the projects that you have on the server or to create a new project.

To open and use the Repository Login dialog box, complete these steps:

1. Select **File --> Connect to DB.**
   
   The Repository Login dialog box appears.

   ![Repository Login Dialog Box](image)

2. Type the name of the repository on the server that you are accessing into the **Repository** field.

3. Type your user name into the **User name** field. This information automatically appears in the **Author** fields of the **Classes** and **Slots** tabs. It also automatically appears in the **Created by** fields of the **Instances Editor** section of the **Instances** and **Hierarchy** tabs.

4. (Optional) Type a password into the **Password** field, if it is necessary to access this database.

5. (Optional) Click the **Remember** check box that is unchecked by default. This box instructs SAS Ontology Management Studio to automatically enter the information entered into the **Repository** and **User Name** fields each time you access this dialog box.

6. Click **OK.**
3.15.2 Open Project Dialog Box

The Open Project dialog box enables you to perform several functions that are essential for new, or existing, projects.

To open and use the Open Project dialog box, select **File --> Open**.

*Display 3-20 Open Project dialog box*

Use the components of this dialog box as explained below

**Project list**

Beneath this heading see the following two headings:

**Project Name**

- see a list of the current projects on the server

**Creator**

- displays the initial project developer for each listed project
### Note
If you click on either of these column headings, the project or creator names are displayed in alphabetical or reverse alphabetical order. You choose the type of ordering.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>click after you select an existing project below the <strong>Project Name</strong> heading and the highlighted project appears in the user interface.</td>
</tr>
<tr>
<td>Cancel</td>
<td>close the Open Project dialog box without opening a project.</td>
</tr>
<tr>
<td>New</td>
<td>select a new project in the New Project dialog box that appears. For more information, see Section 3.15.3 <em>Use the New Project Dialog Box</em> below.</td>
</tr>
<tr>
<td>Delete</td>
<td>select an existing project under the <strong>Project Name</strong> heading and click this button to remove the project.</td>
</tr>
<tr>
<td>Rename</td>
<td>rename the selected project in the Rename Project dialog box. For more information, see Section 3.15.4 <em>Use the Rename Project Dialog Box</em> on page 101.</td>
</tr>
<tr>
<td>Import</td>
<td>choose to import a project in the Import Project Wizard into your the <strong>Instances</strong> tab.</td>
</tr>
<tr>
<td>Export</td>
<td>specify the project to export in the Export Project Wizard. For more information, see Section 3.9.2 <em>Use the Export Project Wizard</em> on page 77.</td>
</tr>
</tbody>
</table>
3.15.3 Use the New Project Dialog Box

Use the New Project dialog box to specify the name of your new project.
To open and use the New Project dialog box, complete these steps:

1. Click **New** in the Open Project dialog box and the New Project dialog box appears.

2. Type the name of the new project into the **Project name** field.

3. Click **OK**.

3.15.4 Use the Rename Project Dialog Box

Use the Rename Project dialog box to specify a new name for your project.
To open and use the Rename a Project dialog box, complete these steps:

1. Click **Rename** in the Open Project dialog box and the Rename Project dialog box appears.

2. Type the new name of the selected project into the **Enter a new name** field.

3. Click **OK**.
3.15.5 Use the Confirm Reset Dialog Box

The Confirm Reset dialog box verifies the command to delete all of the information in your current repository.

To reset the repository, complete these steps:

1. Select **Repository --> Reset**
2. The Confirm Reset dialog box appears.
3. Click **Yes** and SAS Ontology Management Studio screen appears.
4. Click **OK**.
5. Select **File --> Disconnect**.
3.15.6 Use the New User Dialog Box

You, as the project administrator, can use the New User dialog box to add a new user to the project and to specify their password.

To open and use the New User dialog box, complete these steps:

1. Select Repository --> User Management.
2. Select a user in the User Management dialog box that appears.
3. Click New and the New User dialog box appears.

4. Type in the name of the new user into the User name field.
5. Type the new password into the New Password field.
6. Type the password, again, into the Confirm new password field.
7. Click OK.
3.15.7 Use the Change Password Dialog Box

You, the project administrator, can use the Change Password dialog box to change the password for a user.

To open and use the Change Password dialog box, complete these steps:

1. Select Repository --> User Management.
2. Select a user in the User Management dialog box that appears.
3. Click Password and the Change Password dialog box appears.

4. The name of the user automatically appears in the User name field.
5. Type the new password into the New Password field.
6. Type the password, again, into the Confirm new password field.
7. Click OK.
3.15.8 Use the Replace Dialog Box

Use the Replace dialog box to specify a change into the value of the Constraint specified for a selected Slot.

To open and use the Replace dialog box, complete these steps:

1. Click Replace in the Queries tab and the Replace dialog box appears.

2. Click and the Select Items dialog box appears. For more information, see Section 3.15.16 Use the Select Items Dialog Box on page 118.

3. Click to delete a Slot that you added using.

4. Type in the new Instance information, depending on the Constraint type that appears above the blank field.

5. Click OK.

*Notes:* You should perform a Consistency Check after each replace operation. For more information, see Section 3.3.2 Ontology Pane on page 39.
3.15.9 Use the Sort Setting Dialog Box

Use the Sort Setting dialog box to order the display of matching Slots that are returned to your query.

To open and use the Sort Setting dialog box, complete these steps:

1. Click in the Search Results section of the Queries tab and the Sort Setting dialog box appears.

2. Select Case Sensitive to order the matches by uppercase and lowercase letters.

3. Select either A to Z or Z to A.

4. Click to select a Slot from the Select Items dialog box that appears. For more information, see Section 3.15.16 Use the Select Items Dialog Box on page 118.

5. Click to remove the Slot that you entered using .

6. Click OK.
3.15.10 Use the Add a Constraint Dialog Box

The selections that you can make in the Add a Constraint dialog box are limited by the Value Type setting that you choose in the Slots tab. Constraints delimit the Value Type setting for a Slot, and the value that you enter places further limitations on possible Class Instances.

While some value types enable you to enter several values, for other constraints it is not necessary to enter a value.

To open and use the Add a Constraint dialog box, complete these steps:

1. Click the Slots tab to access the Slot Editor section of this tab.

2. Click \( \ldots \) in the Value Type field, or leave the default setting, String.

3. Click \( \ldots \) to the right of the Constraints heading and the Add a Constraint dialog box appears.

4. Click \( \ldots \) in the Constraint field and select a constraint. For more information, see Section 3.15.10.A Understanding Constraint Settings below.

5. Type in a value, or click \( \ldots \) that appears in the Value field and the Select a Class or Select a Slot dialog box appears. For more information, see Section 3.15.11 Use the Select a Class Dialog Box on page 112, Section 3.15.12 Use the Select a Slot Dialog Box on page 113, and Section 3.15.10.B Value Settings on page 110.

6. Click OK.
3.15.10.A Understanding Constraint Settings

See the following Constraint selections and their explanations:

**Default**

specify the value that is automatically entered in the Instance Editor section of the Instances tab. This selection is only available when you select the **Value Type**: Boolean.

**Candidate**

specify a specific value, for example, United States of America. Use the Candidate selection reiteratively to specify all of the possible selections. These entries appear as a drop-down menu in the Instances tab.

**Minimum**

specify the lower bound for this Slot. This is the lowest number that you can enter.

**Maximum**

specify the maximum number, or upper bound, for this Slot. If you specify **Value Type**: String, this setting also applies to the Maximum Length selection explained below.

**Maximum Length**

specify the greatest number of characters that can be used with the **Value Type**: String.

**Unique**

specify a value that cannot be duplicated. Each Instance has a different value specified in this field.

**Multiple Cardinality**

enables Instances to take more than one specified value. Use this selection reiteratively.

**Boolean Rule**

Slots that are defined by the Boolean Rule Constraint are delimited by Boolean rules that are valid according to the requirements specified for Category rules in SAS Content Categorization Studio. This selection is only available for the **Value Type**: String.

Boolean rules apply only to Classifier Concepts, or subclasses of the Entity Class in SAS Ontology Management Studio. You can specify Slots
for Classifier Concepts as TGIF or TGUNLESS fields when you upload the Entity Class to SAS Content Categorization Studio.

**Not NULL**

specify that a value in this field is required in order to update your project

**Allowed Class**

set the **Value Type** in your Slots interface to *Instance Of*

**Recursive**

specify the Class where this Slot was defined or any subclasses for this Class

**Hierarchy Element**

select a Class in the Select a Class dialog box that appears. This selection enable you to create links between Instances of these two Classes in the *Instances* tab.

**Inverse**

place Instances of the selected Slot into an inverse relationship with Instances from the Slot that uses this Constraint

**Regular Expression**

specify a regular expression. This selection enables matches on strings with established language patterns, for example, telephone numbers and e-mail accounts.

**Identifier**

specify a unique qualifier for each Class

### 3.15.10.B Value Settings

Use the **Value** field to specify a numerical, or a character, value that delimits the **Constraint** setting. You can take this action, unless you select one of the following five selections. The **Value** field does not appear for these selections:

- Unique
- Multiple Cardinality
- Not NULL
- Hierarchy Element
- Recursive

Choose one of the following values:
Default for **Value Type**: Boolean

- click either the **Yes** for **True**, or **No** for **False** radio button.

**Candidate**

- create more than one **Value** for a Slot. Each time you enter a **Candidate**, selection, it is added to the Add a Value dialog box that you access in the **Instances** tab. For more information, see Section 3.15.20 *Use the Add a Value Dialog Box* on page 123.

**Minimum**

- specify a minimum **Value** for this field according to the **Value Type** that you chose in the **Slot Editor** section

**Maximum**

- specify the maximum value for the **Value Type** that you entered into the **Slot Editor** section

**Allowed Class**

- click ![image](image.png) to the right of the **Value** field and use the Select a Class dialog box that appears to select the allowed class for this Slot value
3.15.11 Use the Select a Class Dialog Box

Use the Select a Class dialog box to make a Class the Default, or Allowed Class, selection.

To open and use the Select a Class dialog box, complete these steps:

1. Click to the right of the **Constraints** heading and the Add a Constraint dialog box appears.

2. After you have select **Allowed Class** or **Default** as the **Constraint**,

   click in the **Value** field. The Select a Class dialog box appears.
3. Select a Class node in the taxonomy pane.

4. Click OK.

3.15.12 Use the Select a Slot Dialog Box

Use the Select a Slot dialog box to select a Slot when you set the Value Type in the Slot Editor section of the Slots tab to Slot ID. You can only select the Slots that are available for the selected Class.

To open and use the Select a Slot dialog box, complete these steps:

1. Set Slot ID as the Value Type in the Slot Editor section of the Slots tab.

1. Click + to the right of the Constraints heading and the Add a Constraint dialog box appears.

2. Click in the Value field and the Select a Slot dialog box appears.

3. Select a Slot from the list of Slots that appears.

4. Click OK.
3.15.13 Edit Slot Dialog Box

Use the Edit Slot dialog box to change the data entered for your Slot. The Edit Slot dialog box is identical to the Slot Editor section of the Slots tab. It is also identical to the Add a Slot dialog box. The only difference is that the Edit Slot and Add Slot dialog boxes are accessed through the Classes tab and the Slot Editor section is part of the Slots tab.

Display 3-21 Edit Slot dialog box

Also use this interface to access the Edit Value dialog box using the same Edit button. For more information, see Section 3.15.14 Use the Edit Value Dialog Box on page 115.

For more information about the components of the Edit Slot dialog box, see Section 3.4.4 Slot Editor Section on page 49.
3.15.14 Use the Edit Value Dialog Box

You can change a Slot value, using the Edit Value dialog box. This is true whether or not the Slot is inherited, unless you have deselected the default setting *Allow editing inherited slots in sub-classes* in the Preferences dialog box. For more information about this setting, see Section 3.8 *Preferences Dialog Box* on page 72.

To open and use the Edit Value dialog box, complete these steps:

1. Select a Slot in the **Classes** tab and click [ Slot entry ](Slot Entry). Select a Constraint in the Edit Slot dialog box that appears.

1. Click [ Edit Value ](Edit Value) and the Edit Value dialog box appears.

![Edit Value dialog box]

The Constraint field is dimmed.

2. Type the new value into the **Value** field to replace the current entry.

3. Click **OK**.

3.15.15 Use the Permission Editor and Set Permission Dialog Boxes

Use the Permission Editor dialog box to override user permissions set at the database level. These permissions are accessible in the **Classes** and **Slots** tabs. The Permission Editor dialog box and its related interfaces are the same for both Slots and Classes.
The directions provided below are for Classes. Use the same set of directions for Slots, substituting the word Slots for the word Classes, when necessary.

**Note:** If you set group permissions, the permission level is the same for all users in that group.

To open and use the Permission Editor dialog box, complete these steps:

1. Right-click on a node in the taxonomy panes of the **Classes** or **Slots** tabs.
2. Select **Set Permission** and the Permission Editor dialog box appears.

3. Click and the Set Permission dialog box appears.

4. Click in the **User/Group** field and the Permission Editor dialog box appears.
5. Click \( \text{Select Groups/Users} \) and the Select Groups/Users appears

![Select Groups/Users dialog box]

6. Select a user or group of users.

7. Click OK.

8. Click \( \text{Permission} \) in the Permission field and select a permission level in the drop-down menu that appears.

![Set Permission dialog box]

Note: For information about the permission levels, see Section 3.3.3 Class Editor Section on page 40.

9. Click OK.

10. Click OK in the Permission Editor dialog box.

11. (Optional) Click \( \text{Remove User} \) to remove a user with their permission level.
12. (Optional) Click to edit a permission level that you granted to a group.

13. Click OK in the Permission Editor dialog box.

3.15.16 Use the Select Items Dialog Box

Use the Select Items dialog box to locate a Class.

To open and use the Select Items dialog box, complete these steps:

1. Click that appears, for example, to the right of the Domain heading in the Slot Editor section of the Slots tab. The Select Items dialog box appears.

2. Select a Class in the taxonomy pane of the Select Items dialog box.

3. Click OK.
3.15.17 Use the Set Display Slot Dialog Box

Use the Set Display Slot dialog box to choose the information displayed for each Instance in the Instances section of the Instances tab.

To open and use the Set Display Slot dialog box, complete these steps:

1. Click in the Instances section of the Instances tab and select Set Display Slot. The Set Display Slot dialog box appears.

2. Click Use multiple slots and the Set Display Slot dialog box changes to show multiple Slots.

3. Use the blank field before each Slot to enter a separator character. For example, you can enter -, :, ;, or .. These separator characters appear between the displayed Slot values.

4. Click each to select a Slot from the drop-down list.

Note: You do not have to use three Slots for the display. You can use, for example, the first two fields only.
3.15.18 Use the Set Slot Order Dialog Box

Use the Set Slot Order dialog box to rearrange the Slots as they appear under the heading **Instance Information** in the **Instances** tab.

**Notes:** This operation is only available in the **Classes** tab where the Slots were originally created. When you choose to rearrange the Slot order using the **Set Slot Order** dialog box, the ordering of the Slots listed in the **Classes** tab does not change.

To reset the Slot order in the **Instance** tab, complete these steps:

1. Select a Class in the **Classes** tab.
2. Click and the Set Slot Order dialog box appears. The inherited Slots are displayed before the non-inherited Slots. Non-inherited Slots appear in blue font.

3. Choose any of the following operations:

   - Select a Slot and click or to move the Slot up or down.
   - Click the Name heading to reorder your Slots alphabetically, by name.
   - Click the Type heading to reorder your Slots alphabetically, by type.
   - Click the Name heading to reorder your Slots according to whether or not they are inherited.

4. Click OK.
3.15.19 Use the Create a Value Dialog Box

Use the Create a Value dialog box to define a value for a Slot field in the **Instances Editor** section of the **Instances** tab.

To open and use the Create a Value dialog box, complete these steps:

1. Click on the **Instances** tab to see the **Instance Editor** section of the **Instances** tab.

2. Click and the Create a Value dialog box appears.

3. Type the characters that form the value for this Slot into the **Enter a string** field.

4. Click **OK**.
3.15.20 Use the Add a Value Dialog Box

Use the Add a Value dialog box to add multiple values for a Slot in the Instances tab.

To open and use the Add a Value dialog box, complete these steps:

1. Click and the Add a Value dialog box appears.

2. Click in the Select a value from the list field.

3. Click OK.
3.15.21 Use the Save Dialog Box

To open and use the Save dialog box, complete these steps:

1. Click in the **File path** field in the Export Instances of Class wizard, for example, and the Save dialog box appears:

![Save dialog box image]

2. Click in the **Save in** field and select a folder in the drop-down menu that appears.

3. Click a file in the pane below the **Save in** field.

4. Type the new name of the file into the **File name** field.

5. Select .xml as the file type in the **Save as type** field.

6. Click **Save**.
3.15.22 Save As Dialog Box

Use the Save As dialog box to name, and to select a location for, for example, the project that you are exporting using the Export Project Wizard.

Display 3-22 Save As Dialog Box

To use the components of the Save As dialog box, see Section 3.15.21 *Use the Save Dialog Box* on page 124.
3.15.23 Open Dialog Box

Use the Open dialog box to select a project to open.

*Display 3-23 Open dialog box.*

To open and use the Open dialog box, see Section 3.15.21 *Use the Save Dialog Box* on page 124.
3.15.24 Confirm Delete Screen

Use the Confirm Delete dialog box when you change your mind about removing a Slot from the selected Class. This dialog box appears after you select a Slot in the **Classes** tab and click .

Click **Yes** to delete the selected Slot, or click **No** to keep the Slot in the project.
### 3.15.25 Warning Dialog Boxes

Warning dialog boxes appear when you try to delete an Instance that is referenced by another Instance. The Warning dialog boxes display all of the referenced Instances and advise you as to whether or not you can choose to delete the selected Instance.

![Warning Dialog Box](image)

**Tip:** You can delete an Instance that references another Instance, but not one that referenced by another Instance.

Use the components of a Warning dialog box as explained below:

**Message**

advise whether or not you can delete the selected Instance
Instance
the occurrence of each Instance that cannot be deleted, because it is
referenced by another Instance, is listed here. Click this heading to reorder
your Instances.

Referenced By
Instances listed below this heading reference the selected occurrence of
the Instance that you have highlighted for removal purposes

1/1 (or another page count)
page count for the selected page and the total number of pages of
referenced Instances

Buttons
see the table below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>go to the first page of Instances</td>
</tr>
<tr>
<td>![ ]</td>
<td>return to the Instances page that you last viewed</td>
</tr>
<tr>
<td>![ ]</td>
<td>go to the next page of Instances</td>
</tr>
<tr>
<td>![ ]</td>
<td>go to the last page of Instances</td>
</tr>
<tr>
<td>![ ]</td>
<td>OK leave the Warning dialog box</td>
</tr>
</tbody>
</table>
4 Database Operations

- Overview of Database Operations
- Start the SAS Ontology Management Studio Program
- Connect to the Database
- Open an Existing SAS Ontology Management Studio Project
- Exporting and Importing Projects to Your Local Machine
- Using the Maintenance Operations

4.1 Overview of Database Operations

SAS Ontology Management Studio projects are stored on a server that you access from your local machine. You can also use the database to export and to import projects that are stored in the cache of your local machine.

This chapter provides in-depth directions for all of these operations. Some of this material is essential to start your program and to create, and open projects. Other material is relevant only to projects that you have fully developed.

4.2 Start the SAS Ontology Management Studio Program

To start the SAS Ontology Management Studio program, complete these steps:

1. Install the program. For more information, see Section 3.3 Installing Teragram Semantic Term Manager on Windows on page 43 or Section 3.4 Installing Teragram Semantic Term Manager on UNIX on page 56.
2. Use the command line interface to set the project administrators and other users for this project. For more information, see Section 3.6 Adding Users on page 57.


A blank SAS Ontology Management Studio user interface appears.

The SAS Ontology Management Studio user interface is a blank screen until you connect to the repository and create a new, or open an existing, project.
4.3 Connect to the Database

The project administrator logs on to the repository in order to begin using the SAS Ontology Management Studio program. It is, you, the project administrator who can perform the following operations:

- Create a project.
- Define the project users.
- Set access permissions.

Both the project administrator and regular users follow these steps to access the project:

1. Select **File --> Connect to DB**. The Repository Login dialog box appears.

2. Type the name of the database that you are using for this project into the **Repository** field.

3. Type your name into the **User name** field.

4. Type your password into the **Password** field.

5. (Optional) Click **Remember** and you do not have to enter this information each time you access the database.

6. Click **OK** and the Open Project dialog box appears.
4.4 Open an Existing SAS Ontology Management Studio Project

After you connect to the database (see Section 4.3 *Connect to the Database* above), you can start the SAS Ontology Management Studio program and work with either a new or existing project.

To open a project, complete these steps:

1. Click **New** in the Open Project dialog box that appears.

   ![Open Project Dialog Box]

   *Note:* If there are existing SAS Ontology Management Studio projects in this repository, they are displayed in beneath the **Project Name** title. Select the project and click **OK** to open this project.
The **New Project** dialog box appears.

2. Type the name of the new project into the **Project name** field, for example, *New_Project*.

3. Click **OK** and the new project appears in the SAS Ontology Management Studio user interface. The name of the new project, for example, *New_Project*, appears in the Program and Project title bar.
4.5 Exporting and Importing Projects to Your Local Machine

4.5.1 Understanding the Export and Import Operations

Develop SAS Ontology Management Studio projects in a repository. However, you can also choose to export a project to your local machine in order to modify it using a third-party application and then import it back into the repository. For more information, see Section 4.5.2 Export a Project below and Section 4.5.3 Import a Project on page 139.

Notes: Exporting, and particularly importing, a project requires approximately 2 GB of memory. For large projects, you should use the binary file format .tsm instead of the default setting .xml.
4.5.2 Export a Project

To export a project, complete these steps:

1. Select **File > Export**. The Export Project Wizard - Step 1 of 3: Select a project dialog box appears.

2. Select the project that you are working on.

3. Click **Next**. The Export Project Wizard - Step 2 of 3: Specify a location for exported project dialog box appears.
4. By default, XML is selected. Select Binary if you are exporting a large project.

5. Click in the **Where to store exported project file?** field and Save As dialog box appears where you select the folder to store the project. For more information, see Section 3.15.22 *Save As Dialog Box* on page 125.

6. Click **Next** and the Export Project Wizard - Step 3: Success dialog box appears.

![Export Project Wizard - Step 3: Success](image)

7. Click **Finish**.

8. (Optional) To work on this project collaboratively, import the project. For more information, see Section 4.5.3 *Import a Project*.
4.5.3 Import a Project

When you import a project you move the project from your machine to the repository. In order to import a SAS Ontology Management Studio project you use the Import Project Wizard that can be accessed using the File pop-up menu.

To import a project, complete these steps:

1. Select File > Import. The Import Project Wizard - Step 1 of 3: Locate a project file dialog box appears.

2. If the file that you want to import was created in .xml format leave the XML check box selected. If you are importing a large project, click Binary.

3. Click to the right of the Project file field. The Open dialog box appears.

4. Select a file to import.

5. Click Next and the Import Project Wizard - Step 2 of 3: Preview project dialog box appears.
6. Preview the imported project.

7. Click **Next** and the Import Project Wizard - Step 3 of 3: Success window dialog box appears

8. Click **Finish**.
4.6 Using the Maintenance Operations

4.6.1 Understanding the Repository Maintenance Dialog Boxes

Use the Maintenance dialog boxes at both the repository and Class levels to perform general clean up, and find and replace operations. Use this tool to automate the processes of maintaining the values necessary to your Slots.

4.6.2 Use the Repository Maintenance Dialog Box

To open and use the Repository Maintenance dialog box, complete these steps:

1. Select Repository --> Maintenance, before you open, or after you close, a project in SAS Ontology Management Studio. The Repository Maintenance dialog box appears.
2. Click **Clean up all empty slot values** and the **NULL** value is inserted into all of the Slots that do not have a value. This operation enables you to search for **NULL** or **not NULL** Slot values using the **Query** tab.

3. Click **Fill in inverse values** if you created Slots defined by the **Inverse** Constraint. This operation fills in any missing values for these Constraints.

4. Click **Modify slot values of type string** to edit these values.

5. Click **Start** to launch this process and to see the progress in the **Status** pane.

6. Click **Close**.
4.6.3 Use the Class Maintenance Dialog Box

Use the Class Maintenance dialog box like you use the Repository Maintenance dialog box. Unlike the Repository Maintenance dialog box, however, the Class Maintenance dialog box is only used to replace Slot values for the selected Class.

To open and use the Class Maintenance dialog box, complete these steps:

1. Click the **Instances** tab and right-click on a Class in the taxonomy pane.
2. Select **Maintenance** in the pop-up menu and the Class Maintenance dialog box appears.
3. Use Step 2. through Step 4. on page 142.
4. Click to select a Slot from the Select Items dialog box that appears. For more information, see Section 3.15.16 Use the Select Items Dialog Box on page 118.
5. Type the string that you are searching into the **Find** field.
6. Type the string that replaces all of the instances of the found string into the **Replace** field.

7. Click **Start** to launch this process and to see the progress in the Status window pane. The SAS Ontology Management Studio confirmation screen appears.

8. Click **OK** and status messages appear in the **Status** screen at the bottom of the Class Maintenance dialog box.

9. Click **Close**.
5
Creating a New Project

- Understanding Ontologies Creation in New Projects
- Setting User Permissions
- Creating a New Project
- Setting Value Types and Constraining Slots
- Add a Domain
- Removing Classes, Slots and Instances
- Query Instance Values

5.1 Understanding Ontologies Creation in New Projects

Building an ontology is done within the context of a project. An administrator creates the project and can define its Classes. The Slots that determine the metadata types and the Instances of the Classes that meet these Slot requirements are developed by users with appropriate permission levels. For these reasons, a project defines an ontological structure for Categories and Concepts that are comprised of instantiations of metadata. (The terms Concepts and Entities are used interchangeably.)

Both Category and Concept Classes organize and identify the various types of information residing on your organization’s server. By selecting specific terms that you expect to find under various metadata headings, you can create a standardized format where available information is classified.

Category Classes specify the types of data that should be grouped together. Classifier Concepts that are created below the Entity Class node, enable you to specify, with greater precision than is possible in SAS Content Categorization Studio, the strings that are matches in incoming documents.
There are three types of projects that you can create:

- Develop a Categories-only project. When you make this choice, you can create an uploadable taxonomy of Categories. The TK240 parent Slot preserves the Classsubclass relationships defined in SAS Ontology Management Studio. This feature enables you to upload the entire taxonomy intact. You can then write rules in SAS Content Categorization Studio that determine whether or not a document is about a particular Category.

- Develop an entity (Classifier) Concepts project, only. This is the most-frequently used ontology that is created in SAS Ontology Management Studio. Use this selection to write Classifier definitions in greater detail than it is possible to do using SAS Content Categorization Studio. Entity Classes are Classifier Concepts with lists of terms that are matched in input documents. Entity Classes can also be specified by Boolean rules. Although you can define grammar and regular expression (regex) Concepts in SAS Ontology Management Studio, the upload capability for grammar and regex Concepts for SAS Content Categorization Studio is still under development.

- Develop a project that uses both Category and entity Classes by incorporating the Categories that you define into the definitions of the Classifier Concepts that you develop.

Use these selections to create an ontology of information classifications that you can upload to SAS Content Categorization Studio. These classifications are defined as Classes and subclasses and are, in turn, defined by Slots. The Constraints that define Slots also assist in identifying Instances of each Class and its subclasses.

Each Class, or subclass, is defined by Slots and Instances. Slots are the metadata attributes of a Class. Each member of a specific Class has these specified qualities, although the actual instantiations of these attributes can vary. For example, the Slots for the Car Class can include make, type, and color. Instantiations of a particular Class, as defined by the values of the Slots, are called Instances. Continuing with this example, the Car Class can contain an Instance of a Saab sedan that is red, and another Instance that is blue. These Instances can be matched, as Classifier Concepts, when this entity Class is uploaded to SAS Content Categorization Studio and used with SAS Content Categorization Server.
Use Constraints to modify Slot values and to define ontologies of Instances. These ontologies specify hierarchies of interrelated Instances based on shared Slots. For example, the Owner Slot can be used to specify a relationship between an owner and his or her cars. (These ontologies cannot be uploaded at this time.)

Additionally, you can use the Inverse Constraint to define a reciprocal relationship between two Instances that share one type of metadata, or Slot. For example, a coffee shop could offer pairings of donuts and coffee at reduced prices. In this case, each Instance of the Donut Class could be linked to an Instance of the Coffee Class.

5.2 Setting User Permissions

5.2.1 Understanding Permission Levels

Administrative users have full permissions for the project, while permissions for regular users are Class and Slot specific. You can also override these permission levels in the Instances tab. Whatever permission level you select in one tab is, however, related to the permission level that you specify in another tab.

You can assemble users into groups for easier permission setting. When you choose to define groups, the permission level that you set for the group overrides any permissions set for the individuals in that group.

When you specify permission levels, consider the expertise of the developers involved in creating the project. Determine who develops the ontology and define how the various project users and groups can contribute to project development before you begin defining Classes and adding Slots.

5.2.2 Understanding User Types

Only an administrator can add and delete Classes, specify users, and add other project administrators. There are two types of users for a SAS Ontology Management Studio project:
Regular users are the users who do not have administrative privileges for the project. These users are added to the project by an administrator who uses the command line. (For more information, see Section 2.6.3 Add Users on page 21.) Regular users can work on the SAS Ontology Management Studio project according to the default permission levels set in the **Classes** and **Slots** tabs. For more information, see Section 3.15.15 *Use the Permission Editor and Set Permission Dialog Boxes* on page 115.

Administrative users are, by default, the group that is comprised of all of the administrators. These users are also defined in the command line. (For more information, see Section 2.6.3 Add Users on page 21.) Administrators have full permission levels that enable them to create, upload, and edit projects. The administrator is the highest permission level for a group or an individual. This individual or group of users can perform the following actions:

- Add and delete Classes.
- Add or delete users: For more information, see Section 3.15.6 *Use the New User Dialog Box* on page 103.
- Change user passwords: For more information, see Section 3.10.2 *User Management - Users Tab* on page 83. Specify permission levels for specific individuals. For more information, see Section 3.15.15 *Use the Permission Editor and Set Permission Dialog Boxes* on page 115.
- Define groups. For more information, see Section 3.10.3 *User Management - Groups Tab* on page 84.
- Export or Import projects. For more information, see Section 3.9 *Importing and Exporting Projects* on page 77.
- Upload a project to SAS Content Categorization Studio. For more information, see Chapter 6: *Uploading Categories and Concepts*.
- Reset the SAS Ontology Management Studio repository. For more information, see Section 3.14 *Reset Repository* on page 97.

For all other users, the permission levels are explained in the following section.
5.2.3 Selecting Permission Levels

After you create a project, the users that you, the administrator, added at the
database level can access and work on the project according to their
permission levels. By default, the permission level for regular users is set to
Read Only. You, as the project administrator, can reset the permission levels
for each user at the Class, Slot, and Instance levels according to the subject
matter expertise that each user contributes to the project.

Use the following permission levels as they are explained below:

Classes

administrators, only, create Classes and have the All permission level.
Other users can have any of the following permissions settings at this level
of project development:

Read only (default setting)

leave the default setting to enable your users to see this Class and its
Instances without making any changes to this Class, or to its Slots
and Instances

Modify instances

read this Class and modify the values of any existing Instances

Add, delete and modify instances

change, add, and delete Instances using this permission level

Add, delete and modify instances and slots

specify full permissions for Instances and Slots

All

enable administrators to gain the access that is necessary to develop all
components of the project. Administrators can also create projects.

Slots

set this permission level in relation to the level set in the Classes tab

Read only

leave the default setting that enables regular users to read, but not to
make any changes to, this Slot

Modify instance slot value

read the project and modify any existing Slot values for Instances in
the Instance Editor section of the Instances tab
modify this Slot and its Instances, and set a default permission level for this Slot. These users can also modify Slot data, for example, **Domain, Constraint, and Value Type** settings. However, these users can only make these changes if they have this permission level setting for both Classes and Slots.

**Slots**

specify the following permission levels for users if you are an administrator:

- **Read only** (default setting)
  
  enables regular users to read, but not to make any changes to, this Slot

- **Modify instance slot value**
  
  read the project and modify any existing Slot values for Instances in the **Instance Editor** section of the **Instances** tab

**All**

modify this Slot and its Instances, and set a default permission level for this Slot

**Instances**

set permissions for individuals or groups in the Permission Editor dialog box that appears. For more information on the permission levels that are available here, see **Classes** above.
5.2.4 Understanding Interrelated Permissions

The permissions that you set at the Class and Slot levels for regular (non-administrative users) are interrelated. In other words, permissions for each Class and Slot function together. Permissions for a Slot cannot conflict with those set for a Class when this Slot defines a value for the selected Class.

This is also true for Instances, where the permission levels set here override those set at the Class and Slot levels.

For example, if a group of users have the permission setting Modify instances for the Cars Class, but a Read only permission setting for the Color Slot they cannot modify a value for the Color Slot in the Instances tab. However, these users might be able to modify other Slot values for existing Instances of the Cars Class.

Set permissions for individuals that override the default permission levels set at the Class and Slot levels in the Instances tab. For example, you could set the Default Class Permission setting to Add, delete and modify instances and slots. You can use the Slot setting Default Permission setting Modify instance slot value. However, if you then set this user’s permission level to Read Only in the Instances tab, this user can see this Class with its Slots and Instances, but not make any changes.

5.2.5 Specify Regular User Permission Levels

To specify a permission level for an individual using the Instances tab, complete these steps:

1. Right-click on a Class node, for example, Autos, in the ontology section of the Classes tab. Select Set Permission from the pop-up menu. The Permission Editor dialog box appears.
2. Click ![image](image1.png) and the Set Permission dialog box appears.

![Set Permission dialog box](image2.png)

3. Click ![image](image3.png) to the right of the **User/Group** field and the Select Groups/Users dialog box appears.

![Select Groups/Users dialog box](image4.png)

4. Select a user from the list of users that were added at the command line.

**Note:** If you have already defined groups using the **User Management - Groups** dialog box, you can select a group instead of an individual. For more information, see Section 3.10.3 **User Management - Groups Tab** on page 84.
5. Click OK and the Set Permission dialog box displays the name of the user or group that you selected.

![Set Permission dialog box]

6. Click to select a permission level from the drop-down menu. For more information, see Section 5.2.3 Selecting Permission Levels on page 149.

7. Click OK.

8. Click OK in the Permission Editor dialog box.

5.3 Creating a New Project

5.3.1 Define a Class

This section explains how to create an entity Class. Although you can use this section to also create Category Classes, SAS Ontology Management Studio is designed to allow you to develop Concepts in greater detail than it is possible to do with SAS Content Categorization Studio alone. Modify the steps below, as necessary, to define Category Classes.

To define an entity Class, complete these steps:

1. Right-click on the Entity Class node in the taxonomy section of the Classes tab and select Create Subclass from the pop-up menu that appears.

2. Type the name of the added Class into the Class Name field of the Class Editor section of the Classes tab.
3. Type an explanation for the Class into the **Description** field.

**Tip:** If you do not rename this Class, the node is not saved when you leave this tab.

4. Click 📌 to select a permission level from the drop-down menu in the **Default Class Permission** field. The permission level for this Slot applies to all users who are not administrators and who do not have their permission levels individually reset in the Set Permission dialog box:

- **Read only** *(default setting)*
  - leave the default setting to enable your users to see this Class and its Instances without making any changes to this Class, or to its Slots and Instances
- **Modify instances**
  - read this Class and modify the values of any existing Instances
- **Add, delete and modify instances**
  - change, add, and delete Instances using this permission level
- **Add, delete and modify instances and slots**
  - specify full permissions for Instances and Slots
- **All**
  - enable administrators to gain the access that is necessary to develop all components of the project. Administrators can also create projects.

5. Click **Update** and the selected node name is saved. This action also saves your project to the repository.

6. Begin adding Slots. For more information, see Section 5.3.2 *Adding Slots* below.
5.3.2 Adding Slots

5.3.2.A Understanding Slots

You add Slots to your Classes for the purposes of specifying the metadata that defines your Classes. When you define Slots, you also define one Slot whose value is used as the display name for each of the Instances defined for this Class.

If you define Categories, add the Slot that sets the display name at the **THING** node level. Specify **Value type** as **String**. This Slot is used to set the names for all of the Classes that are uploaded to SAS Content Categorization Studio.

**Hint:** You can add a Slot named **ID** to the **THING** node. This Slot enables you to set a unique, identifying number for each Instance. For more information, see Section 5.4.16 *Specify Identifier* on page 188.

Before you define any of your Slots, consider your Classes. For example, if you want a Slot to apply to one Class, only, you define and use the Slot within the selected Class. However, if you want a Slot to constrain several Classes, consider adding the Slot to a parent Class or adding the relevant Classes to the domain for that Slot.
5.3.2.B Add Slots

To add Slots to your Classes, complete these steps:

1. Click to add a Slot to the selected Class.
The Add a Slot dialog box appears.

2. Type the name of the Slot into the **Slot Name** field.

   **Note:** The **OK** button is only accessible when you enter a string into the **Slot Name** field.

3. The name of the person who created the project is automatically entered into the **Author** field.

4. Click to select a permission level from the drop-down menu in the **Default Permission** field. The permission level for this Slot applies to all users who are not administrators and who do not have their permission levels individually reset in the Set Permission dialog box:

   - **Read only** *(default setting)*
     - enables regular users to read, but not to make any changes to, this Slot

   - **Modify instance slot value**
     - read the project and modify any existing Slot values for Instances in the **Instance Editor** section of the **Instances** tab
modify this Slot and its Instances, and set a default permission level for this Slot

5. Type information about the Slot that you define into the Description field.

6. Leave the default setting as String in the Value Type field. Alternatively, click to select a new value from the drop-down menu that appears. For more information, see Section 3.4.4 Slot Editor Section on page 49.

7. Click to the right of the Constraints heading and the Add a Constraint dialog box appears.

8. Click to select a constraint from the drop-down menu that appears below the Constraint field. For more information, see Section 3.15.10 Use the Add a Constraint Dialog Box on page 107.

9. (Use this step if a second field, for example, Value appears in the Add a Constraint dialog box.) Type in a value for this Constraint.

10. Click OK.

11. Click OK in the Add a Slot dialog box.

12. Click to the right of the Domain field of the Slots tab to constrain another Class using this Slot.

13. Click Update and the selected node name is saved. This action also saves your project to the repository.
14. Continue to add Slots, as required.

5.3.3 Creating an Instance

5.3.3.A Understanding Instances

Define the Instances of each of the Classes that you add to your ontology according to the metadata that your Slots define. In other words, the Slots identify the metadata, or the data on the data, in your Classes. Each Instance of a Class conforms to the specifications set by the Slots in order to be a match and a member of the selected Class.

**Note:** Use this section after you use Section 5.4 Setting Value Types and Constraining Slots on page 164.
You can define Instances for Classes when the **Abstract** field in the **Classes** tab remains unchecked. This is also true when the **Inactive** check box is selected or deselected.
5.3.3.B Define an Instance

To create Instances for your Class, complete these steps:

1. Click the **Instances** tab and click ![add instance icon] to add an Instance to the selected Class.

When you add an Instance to your Class, the **Instance Editor** section of the **Instances** tab is visible. Use the Slot fields in this section of the **Instances** tab to name and define the Slot values for this Instance.

2. Click **Update**.
3. Click and select **Set Display Slot** from the drop-down menu that appears. The Set Display Slot dialog box appears.

![Set Display Slot dialog box](image)

4. Click to select a Slot in the drop-down menu that appears.

5. Click **OK**.

6. Type the name of the new Slot into the **Slot Name** field in the **Instance Editor** section of the **Instances** tab. For example, type Prius into the *Name* Slot.

![Instance Editor screenshot](image)
7. Click **Update**.

8. Continue specifying the Slot values for this Instance.

9. (Optional) To see, but not change, the Slots and values that SAS Ontology Management Studio automatically adds to the **Instance Editor** section, click to the left of the **Instance Information** heading.

When you create all of the Instances for this Class you can upload it to SAS Content Categorization Studio. For more information, see Chapter 6: *Uploading Categories and Concepts*. You can also export your Instances. For more information, see Section 4.5.2 *Export a Project* on page 137.
5.4 Setting Value Types and Constraining Slots

5.4.1 Understanding Value Types and Constraints

Value types set the allowed values for your Slots. In turn, these value types delimit the types of Constraints that are used with your Slots. Together these two settings specify the types of metadata that determine the Slot metadata for each Instance of a Class.

For example, if you want to set Colors as metadata for the Class Cars, you can specify that the Value Type is String. This means that only a string of characters can be matched to the Colors Slot. However, you might also ask if there is one color, or several colors? Is there a maximum number of characters? Do you want to specify a default color when none is specified? Can this Slot be empty? Or does it require a value? Finally, does only one of these questions apply to this Slot? Or do multiple questions apply?

As you answer these questions you can use the following sections to specify the applicable values and Constraints.

5.4.2 Open the Add a Constraint Dialog Box

To open the Add a Constraint dialog box, use this step:

Click to add a Constraint in the Slots tab and the Add a Constraint dialog box appears.
Use the **Value Type** selections that are available in the **Slots** tab with the Add a Constraint dialog box to define the metadata that you choose to locate in input documents after you upload your Classes to SAS Content Categorization Studio. For more information, see Section 3.15.10 *Use the Add a Constraint Dialog Box* on page 107.

### 5.4.3 Specify the Default Constraint

Use the **Value Type** Default selection in the Add a Constraint dialog box to specify a value that is automatically used to define each newly-created Instance. This choice saves you the time of entering a commonly-used value repeatedly. You can also choose to overwrite this selection, or decide to add this value to Instances created before this Constraint was defined.

To set the Default Constraint, complete these steps:

1. Create a new Slot in the **Classes** tab and name this Slot in the Add a Slot dialog box that appears.

2. Click \( \text{ } \) and select **String** in the drop-down menu of the **Value Type** field in the Add a Slot dialog box.

3. Click \( \text{ } \) to the right of the **Constraints** heading and the Add a Constraint dialog box appears.

4. Click \( \text{ } \) and select **Default** in the drop-down menu of the **Constraint** field.

5. Type, for example, red, into the **Value** field.

6. Click **OK**
7. Click **OK** in the Add a Slot dialog box.

8. Click **Update** in the **Classes** tab.
5.4.4 Specify Class or Slot ID Constraints

When you specify either a Class ID, or a Slot ID, as the Value Type for your Slot, the value for the instantiation of a Class Instance is the selected Class or Slot. The steps below are for Class ID. Adjust these actions as necessary for Slot ID.

To set Class ID as the Constraint for your Slot, complete these steps:

1. Create a new Slot in the Classes tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and select Class ID in the drop-down menu of the Value Type field in the Add a Slot dialog box.

3. Click to the right of the Constraints heading and the Add a Constraint dialog box appears.

4. Click and select Default in the drop-down menu that appears below the Constraint field.

5. Click in the Value field.
6. The Select a Class dialog box appears.

![Select a Class Dialog Box](image)

7. Select a Class.
8. Click OK.
9. Click OK in the Add a Constraint dialog box.
10. Click OK in the Add a Slot dialog box.
11. Click Update in the Classes tab.

### 5.4.5 Specify the Allowed Class

Use this selection to limit the Instances that can be used to define another Instance. For example, you might want to specify that the Instances used as values for a Slot that is constrained by the Recursive value are limited to those from the SUV Class.

The Allowed Class Constraint, like Recursive, Inverse, and similar Constraints, is only enabled when you select Instance Of in the drop-down Value Type menu that is located in the Slot Editor section of the Slots tab.
To specify a Class for this Slot, complete these steps:

1. Create a new Slot in the **Classes** tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and select **Instance of** in the **Value Type** field in the Add a Slot dialog box.

3. Click \( + \) to the right of the **Constraints** heading and the Add a Constraint dialog box appears.

4. Click and select **Allowed Class** in the drop-down menu that appears below the **Constraint** field.

5. Click \( \ldots \) in the **Value** field and the Select a Class dialog box appears. Use this dialog box to select your Class. For more information, see Section 3.15.11 *Use the Select a Class Dialog Box* on page 112.

6. Select a Class.

7. Click **OK**.

8. Click **OK** in the Add a Constraint dialog box.
9. Click **OK** in the Add a Slot dialog box.

10. Click **Update** in the **Classes** tab.

### 5.4.6 Specify Hierarchy Elements

Use the **Hierarchy** Constraint to define an ontology of relationships between your Instances. Use this selection if you do **not** plan to upload your Instances to SAS Content Categorization Studio. For this reason, there are no specifiable values for this selection in the Add a Constraint dialog box. The **Hierarchy Element** selection, like the Recursive, Inverse, and similar selections, is only enabled when you choose **Instance Of** as the **Value Type** for a Slot.

**Note:** At this time, the hierarchical feature works only for SAS Ontology Management Studio. In other words, while Instances can be uploaded to SAS Content Categorization Studio, their ontologies cannot.

To create an ontology of Instances using the **Hierarchy Element**, complete these steps:

1. Create a new Slot in the **Classes** tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and select **Instance of** in the **Value Type** field in the Add a Slot dialog box.

3. Click to the right of the **Constraints** heading and the Add a Constraint dialog box appears.

4. Click and select **Hierarchy Element** in the drop-down menu that appears below the **Constraint** field.

5. Click **OK**.

6. Click **OK** in the Add a Slot dialog box.

7. Click **Update** in the **Classes** tab.
8. Click the **Hierarchy** tab and click ![Diagram](image.png) that is located to the right of the hierarchy Slot.

The **Select Instance** dialog box appears.

9. Select a Class in the **Allowed Classes** pane and select the Instance that you want to be in a hierarchical relationship to the Instance that you selected in the **Hierarchy** tab.

10. Click **OK**.

11. Click **Update** in the **Instances** tab.
12. Click ![image](image1.png) to see the hierarchical relationship created between the two Instances in the **Hierarchy** tab.

13. (Optional) Continue specifying hierarchical relationships.

**Warning:** Delete the Slots that define interrelationships with care. When you remove these Slots, you lose all of the interrelationships that you defined.
5.4.7 Specifying Inverse

5.4.7.A Understanding the Inverse Constraint

An inverse relationship defines a connection between instantiations of seemingly opposite Classes. This connection is defined when two Slots are identified as the inverse of each other. For example, if a builder is advertising homes for sale, he or she could create a Houses Class. Two of the subclasses for Houses might be Deluxe and Standard. Inverse Slots could be used, in this case, to list the available features for these two types of homes based on instantiations of the opposite Class. In this case, the various deluxe homes incorporate all of the features of some standard homes, while each standard home can be upgraded with a feature package that is defined by the Slot values for a deluxe home.

For this reason, the Slot Standard Features for the Deluxe Class would take as its value an instantiation of one of the Standard Class homes. For example, a three-bedroom deluxe home could incorporate all of the features of a three-bedroom condo, but also use the other Slots for the Deluxe Class to define the additional features of this deluxe home. After this value is entered, and the project is updated, SAS Ontology Management Studio automatically applies the inverse instantiation (in this case, the deluxe three-bedroom home) as a value for the Slot Available Upgrades for the standard three-bedroom home.

When you choose to use Inverse Slots, you define two Slots whose instantiated values reflect all of the values that define another Instance. The two Instances that take each other as a Slot value are in an inverse relationship to each other. Furthermore, you only need to enter one Slot value and the inverse value is automatically entered for you by SAS Ontology Management Studio.

The Inverse Constraint, like the Hierarchy Element, Recursive, and other selections, is only enabled when you select Instance Of as the Value Type for a Slot. You also define the Allowed Class Constraint for the Class whose Instances are the values for this Slot. When you create two inversely-related Slots, you define one Slot without specifying its Constraint until after you have defined the second Slot that takes the first Slot as its Constraint.
### 5.4.7.B Specify Inverse Relationships

To define two reciprocal, inverse Slots, complete these steps:

1. Create a new Slot in the **Classes** tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and select *Instance of* in the drop-down menu of the **Value Type** field in the Add a Slot dialog box. You continue to define this Slot later in the process.

3. Add and name a second Slot. This Slot holds the **Inverse Instances** for this Slot.

4. Click and select *Instance of* in the **Value Type** field in the Add a Slot dialog box.

5. Click to the right of the **Constraints** heading and the Add a Constraint dialog box appears.

6. Click and select *Inverse* in the drop-down menu that appears below the **Constraint** field.

7. Click in the **Value** field and the Select a Slot dialog box appears.

8. Select the Slot that you want to be in an inverse relationship with the selected Slot.

9. Click **OK**.

10. Repeat Step 5 above through Step 9 above, but select *Allowed Class* in the drop-down menu of the **Constraint** field.

11. Repeat Step 4 through Step 10 above for the first Slot that you defined in Step 2 above.

12. Click **OK** in the Add a Slot dialog box.
13. Click **OK** in the Add a Slot dialog box.
14. Click **Update** in the **Classes** tab.

### 5.4.7.C Define Inverse Slot Values

To define the Inverse Slot values in the **Instances** tab, complete these steps:

1. Select an Instance in the **Instances** tab that you want to use to define an inversely-related Instance.
2. Click in the **Slots** tab and the Select Instance dialog box appears where you select an Instance.

![Select Instance Dialog](image)

3. Select a Class and an Instance of that Class. Alternatively, click **New Instance** to create a new Instance in the Edit Instance dialog box that appears.

4. Click **OK**.

5. Click **Update** in the **Instances** tab.

6. Repeat Step 1 through Step 5 above to define all of your related Instances.
5.4.8 Understanding Recursive

*Recursive* means that the Slot refers to the Class that it was created to modify, only. However, recursive can also be used to refer to any subclasses defined for this Class. The *Recursive* selection, like *Allowed Class*, is only enabled when you select *Instance Of* in the *Value Type* field of the *Slots* tab. When you choose *Recursive*, the *Value* field is not enabled in the Add a Constraint dialog box.

Use the *Instances* tab and the Select Instance dialog box to select an Instance in this Class. For more information about these interfaces, see Section 5.4.7 *Specifying Inverse* on page 173.
5.4.9 Specifying Multiple Cardinality

5.4.9.A Understanding Multiple Cardinality

Use the Multiple Cardinality Constraint to enable each Instance to have more than one value. For example, enable the Class Standard to have instantiations where the Slot Color can contain more than one color, depending on the type of home instantiated. You might specify white, yellow, and blue for the Martingale instantiation using the Instance Editor section of the Instances tab. You can then specify the colors, blue, green, and white as the Slot values for the Seaport instantiation.

The Multiple Cardinality selection differs from the Candidate selection. When you select Multiple Cardinality, you do not enter any values in the Add a Constraint dialog box. Instead, you enter them into the Instance Editor section of the Instances tab.

You can enter multiple values for the Instance that is constrained by a Multiple Cardinality Constraint. Add these additional values when you click for these Slots in the Instances tab.
5.4.9.B Specify Multiple Cardinality

To define multiple values for the selected Instance, complete these steps:

1. Click to the right of the Slot that is constrained by Multiple Cardinality and the Create a Value dialog box appears.

2. Type in the characters that define the first value into the Enter a string field.
3. Click OK.
4. Use Step 1 through Step 3 above to specify all of the values for this Slot.
5. Click Update in the Instances tab.

5.4.10 Specify Candidates

The Candidate Constraint presets one or more values for a Slot. For example, you might create the Cost Slot and specify several dollar amounts for each type of home as a Candidate Constraint. Use this Constraint to define a preset cost for each Instance of the Standard homes Class from the drop-down list that appears in the Instances tab for this Slot.

When you choose to restrict the Value Type setting for a Slot to String, Integer, Float, Class ID, or Slot ID, you can add the Candidate Constraint, using a different Value setting each time.
To define one or more Candidate Constraints, complete these steps:

1. Create a new Slot, for example, Cost, in the Classes tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and select a value that appears in the drop-down menu below the Value Type field in the Add a Slot dialog box. Choose, for example, String, Integer, or Float.

3. Click and the Add a Constraint dialog box appears.

4. Click and select Candidate in the drop-down menu that appears below the Constraint field.

5. Type an entry into the Value field, for example, 125000.00.
6. Click **OK**.
7. Click **OK** in the Add a Slot dialog box.
8. Click **Update** in the **Slots** tab.
9. Use Step 2 through Step 8 above, reiteratively, until you have added all of the values that are the selections for this Slot. For example, you can add 50000.00, 25000.00, 75000.00, and 10000.00.

### 5.4.11 Specify a Boolean Rule

You can create a Slot that uses Boolean rules to define an Entity Class. Boolean rules enable you to define complex strings that can be used to define terms that are, or terms that are not, a match.

When you upload a Concept to SAS Ontology Management Studio, specify that the Slots defined by a **Boolean rule** are either **_TGIF** or **_TGUNLESS** rules. Only one of these fields can be specified for each Boolean rule. For more information, see Chapter 6: *Uploading Categories and Concepts*.

To create a Slot that is defined by a Boolean rule, complete these steps:

1. Create a new Slot, for example, Paint, in the **Classes** tab and name this Slot using the Add a Slot dialog box that appears.

2. Click and select **Boolean** in the drop-down menu that appears below the **Value Type** field in the Add a Slot dialog box.

3. Click and the Add a Constraint dialog box appears.
4. Click and select **Default** in the drop-down menu that appears below the **Constraint** field.

5. Leave the default value **Yes** selected and the input documents with a match on the Boolean rule that evaluate to **True** are a match for this Concept. Alternatively, select the **No** radio button to specify that input documents with a match on the Boolean rule that evaluates to **False** do not match for this Concept.

6. Click **OK**.

7. Click **OK** in the Add a Slot dialog box.

8. Click **Update** in the **Classes** tab.

9. Select the **Instances** tab where you type in the Boolean rule.

10. Click **Update** in the **Instances** tab.
11. SAS Ontology Management Studio automatically checks the input Boolean rule and alerts you when this rule is incorrect. See the Information screen that appears.

![Information Screen]

**Note:** Remember to specify `__TGIF` or `__TGUNLESS` when you upload this Class. For more information, see Chapter 6: *Uploading Categories and Concepts.*

5.4.12 Specify Regular Expressions

Regular expressions locate patterns within input document that are more powerful than simple string matching. They are useful for locating multiple instances of preset patterns. For example, use regular expressions to locate phone numbers, e-mail addresses, and street addresses.

You can use a Regular Expression to constrain a Slot with a String value type, only. When you specify a regular expression, you can input values for this Slot that are a match the regular expression, exactly. For example, if you specify a Constraint with the value `\d{4}-\d{1,2}-\d{1,2}`, matches on a date using the following format 2009-5-22 are returned. Incorrect matches include May, 22, 2009 and 7/4/09. For more information about Teragram regular expressions, see Appendix C.
To specify regular expressions, complete these steps:

1. Create a new Slot, for example, Date Sold, in the Classes tab and name this Slot using the Add a Slot dialog box that appears.

2. Click and select String in the drop-down menu that appears below the Value Type field in the Add a Slot dialog box.

3. Click and the Add a Constraint dialog box appears.

4. Click and select Regular Expression in the drop-down menu that appears below the Constraint field.

5. Type in the regular expression that specifies the value for this Constraint in the Value field, for example, \d{4}-\d{1,2}-\d{1,2}.

6. Click OK.

7. Click OK in the Add a Slot dialog box.

8. Click Update in the Classes tab.

9. Click the Instances tab where you can write your Boolean rule.

10. Type a value that matches the regular expression that you defined in the Regular Expression Slot field, for example, Date Sold.

11. Click Update in the Classes tab. The value that you entered for the regular expression is validated.
5.4.13 Specify Minimum, Maximum, and Maximum Length

These three Constraints set upper (or lower) bounds on the number or string that you entered into the Value Type field for the selected Slot. The difference between Minimum and Maximum, as also contrasted with Maximum Length, is as follows. Minimum and Maximum apply only to numbers (Integer and Float). Maximum Length can only be used with strings. (Strings can also contain numbers.) The following steps are for the Minimum value, adapt them for Maximum and Maximum Length.

To specify a Minimum Constraint, complete the following steps:

1. Create a new Slot in the Classes tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and select Integer (or Float) in the drop-down menu that appears below the Value Type field in the Add a Slot dialog box. Alternatively, select String for the Value Type, if you are using the Maximum Length selection.

   **Hint:** If you select Float, you do not need to enter the decimal point. It is automatically added for you.

3. Click and the Add a Constraint dialog box appears.

4. Click and select Minimum in the drop-down menu that appears below the Constraint field.
5. Type a value, for example, 2, into the **Value** field.

6. Click **OK**.

7. Click **OK** in the Add a Slot dialog box.

8. Click **Update** in the **Classes** tab.

9. Click the **Instances** tab where you can enter the value for the newly-created Slot.

10. Repeat this process if you want to specify **Minimum** and **Maximum** values for a Slot.

### 5.4.14 Specify Unique

The Constraint **Unique** means that the value that defines this Slot cannot contain a duplicate value. The **Unique Constraint** modifies the same value types that are constrained by the **Minimum**, **Maximum**, and **Maximum Length Constraints**. These are **Integer**, **Float**, or **String**.

To define a unique Slot value, complete these steps:

1. Create a new Slot using the **Classes** tab and name this Slot in the Add a Slot dialog box that appears.

2. Click ![icon](icon.png) and select **Integer**, **Float** or **String** in the drop-down menu that appears below the **Value Type** field in the Add a Slot dialog box.

3. Click ![icon](icon.png) in the Add a Slot dialog box and the Add a Constraint dialog box appears.
4. Click and select Unique in the drop-down menu that appears below the Constraint field.

5. Click OK.

6. Click OK in the Add a Slot dialog box.

7. Click Update in the Classes tab.

8. Click the Instances tab where you can enter the value for the newly-created Slot.

If you later enter the same value for another Instance, an Information screen appears. (The message in this screen refers to the Instance by its internal, not its displayed name.)

5.4.15 Specify Not NULL

The presence of the Not NULL Constraint mandates that each Instance has a value entered for this Constraint.

To constrain a Slot with the Not NULL selection, complete these steps:

1. Create a new Slot in the Classes tab and name this Slot in the Add a Slot dialog box that appears.

2. Click and choose one of the selections that appear in the drop-down menu below the Value Type field of the Add a Slot dialog box.

3. Click in the Add a Slot dialog box and the Add a Constraint dialog box appears.
4. Click and select Not NULL from the drop-down list that appears below the Constraint field. (The Value field disappears when you make this selection.)

5. Click OK.

6. Click OK button in the Add a Slot dialog box.

7. Click Update in the Classes tab.

8. Click the Instances tab where you can type in the value for the newly-created Slot.

   If you do not enter a value when you click Update, an Information screen appears that asks you to make this change.

5.4.16 Specify Identifier

When set, the Identifier Constraint contains a string for the purposes of uniquely identifying the selected Instance. Like the Not NULL Constraint, the Identifier Constraint requires a value for each newly-created Instance before the Instance can be updated or saved to the repository. This selection is only available when the Value Type in the Add a Slot dialog box is set to either String or Integer.

To set the Identifier Constraint, complete these steps:

1. Create a new Slot using the Classes tab and name this Slot using the Add a Slot dialog box that appears.

2. Click and choose one of the selections that appear in the drop-down menu below the Value Type field, with the exception of Boolean.
3. Click in the Add a Slot dialog box and the Add a Constraint dialog box appears.

4. Click and select Identifier from the drop-down menu that appears below the Constraint field. (The Value field disappears when you make this selection.)

5. Click OK.

6. Click OK in the Add a Slot dialog box.

7. Click Update.

8. Click the Instances tab where you can type in the value for the newly-created Slot.

   If you do not enter a value when you click Update, an Information screen appears that asks you to make this change.
5.5 Add a Domain

The **Domain** pane of the **Slots** tab lists the Classes that are constrained by the selected Slot. The Class where this Slot was originally defined automatically appears in the **Domain** pane. You can also choose to constrain another Class using this Slot. The new Class, and any additional Classes that you add, appear in the **Domain** pane. The following steps can also be adopted for use with the Add a Slot and Edit Slot dialog boxes.

**Tip:** The newly-added Slot is inherited by all of the subclasses of the Class where it was added.

To add Classes to the **Domain** pane, complete these steps:

1. Click ![Image](image.png) to the right of the **Domain** heading in the lower-right corner of the **Slots** interface. The Select Items dialog box appears.

![Image](image.png)

2. Select a Class from the ontology displayed in the **Select Items** window, for example, Car.

3. Click **OK**.
The new Class, for example, *Generic Class*, is displayed beneath the **Domain** heading in the **Slots** tab.

4. Click **Update**.

5. (Optional) If you select the **Classes** tab and select the newly-added Class, you can see that the new Slot is added to this Class.

### 5.6 Removing Classes, Slots and Instances

#### 5.6.1 Delete Classes and Slots

To delete Classes and Slots from a project, complete these steps:

1. Right-click on a Class or a Slot and select **Delete**. The Confirm Delete dialog box appears.

![Confirm Delete Dialog](image)

2. Click **Yes**.

#### 5.6.2 Understanding How Removing and Deleting Instances Differ

The process of removing Instances differs from those of removing Classes and Slots. For example, you can remove multiple Instances at one time, but you can only remove a single Slot or Class with each delete operation.
5.6.3 Use Remove Buttons

After you select a single Instance to remove, click \( \text{to delete this} \) Instance. If, on the other hand, you choose to delete all of the Instances listed in the Instances pane of the \textbf{Instances} tab, click \( \text{. You do not need to select any Instances.} \)

5.6.4 Use Other Instance Removal Options

Use standard Window operations to remove your Instances.

5.7 Query Instance Values

Use the \textbf{Queries} tab to find and replace values entered for Instances in the \textbf{Instance Editor} section of the \textbf{Instances} tab. The \textbf{Queries} tab provides a simple and efficient way to locate Instances that contain the specified alphanumeric characters or Instances of Allowed Classes for the selected Slot under the specified \textbf{Condition}.

When you choose to use the \textbf{Queries} tab you can locate and return Instances without opening the \textbf{Instances} tab to manually find the entries for the Slot values entered for each Instance of a Class. You can also perform a replace operation without re-entering these values.
To open and use the **Queries** tab, complete these steps:

1. Open your project and select the **Queries** tab.

2. (Optional) Click and select a Class in the Select Items dialog box that appears. Use this choice to replace the default selection **All Classes** in the Classes field. This selection specifies what Class, or Classes, are searched.

3. The **Select Items** dialog box appears.

4. Select a Class.
5. Click **OK**.

6. (Optional) Click to the right of the **Slot** heading to replace the **All Slots** default setting in the **Slot** field.

7. The **Select Items** dialog box appears.

![Select Items dialog box]

   a. Select a Slot.
   
   b. Click **OK**.

8. (Optional) The default **Condition** selection, **Is**, appears. To change the condition, click and choose one of the following selections in the drop-down menu that appears:

   - **Is**
     - the entered string is the totality of a Slot value entry
   - **Is not**
     - the entered string does not represent the Instance
   - **Begins with**
     - the first letters of the Slot value
   - **Ends with**
     - the last letters of the Slot value
Contains
  is found within
Does not contain
  is not found within

For the following two values, no entry is necessary in the Slot field in the Queries tab or in the Replace dialog box. For more information, see Section 3.15.8 Use the Replace Dialog Box on page 105.

Is NULL
  no value, or False, in Boolean terminology
Is Not NULL
  has a value, or is True, in Boolean terminology

9. Enter the Instance value that you are searching in the blank field to the right of the Condition field.

Note: If you select Is Not NULL, there is no need to select a value.

10. Click Find.

Note: The Match All radio button is selected (by default). If you instead wanted to find part of the string, for example, red in the string redsox (where these two separate words are joined for the purposes of the example only), you could select the Match Any selection.
11. (Optional) To replace a value, click **Replace** and the Replace dialog box appears.

![Replace dialog box](image)

12. Click **Add**.

13. Select a Slot in the Select Items dialog box.

14. Type in a value, for example, the **String** RiversEdge.

15. Click **OK**.

16. Click **OK** and the replacement results are displayed in the **Search Results** pane of the **Queries** tab.

17. You can now open the **Instances** tab to check your results.

18. Click **Clear** to reset the **Query** tab to its default setting.
19. (Optional) Click More to add additional rows.

20. Define a new search by adding information to the additional rows.

21. Compare the Search Results by deselecting and selecting rows using the check box to the left of each row.

For more information, see Section 3.7 Queries Tab on page 67.
6
Uploading Categories and Concepts

- Overview of the Upload Operations
- Using the Category Class Uploading Wizard
- Using the Entity Class Uploading Wizard

6.1 Overview of the Upload Operations

After you develop your project, you can upload it to SAS Content Categorization Studio. Category and Entity Classes are uploaded differently. You upload the entire taxonomy of Category Classes, but you upload each Concept Class individually to SAS Content Categorization Studio. After you specify the rules and definitions for these Classes in SAS Content Categorization Studio, they can be automatically applied to input documents using SAS Content Categorization Server.

At this time, SAS Ontology Management Studio supports Categories and Classifier Concepts uploads—only.
6.2 Using the Category Class Uploading Wizard

6.2.1 Understanding the TK240 Parent Slot

The Category Class contains a single Slot, by default, the TK240 parent. The Type is Instance of. This Slot cannot be changed or deleted. It is necessary to upload your Classes to SAS Content Categorization Studio.

Display 6-1 TK240 Parent Slot

You can select the Instance to use to upload your Category Classes to SAS Content Categorization Studio using the Instances tab. The Instance that you select corresponds to the Top Category node in the SAS Content Categorization Studio taxonomy. The Top node is located at the top of the hierarchy and has no rules. In SAS Ontology Management Studio the value for the TK240 parent Slot should be itself.

Specify a Slot with the Value type String for every Category in the SAS Ontology Management Studio project. Use this Slot to specify the name of the Category when it is uploaded to SAS Content Categorization Studio. For more information, see Section 5.3.2 Adding Slots on page 155.
6.2.2 Upload Category Classes

Use the Category Class Uploading Wizard to upload the taxonomy of Categories that you created in SAS Ontology Management Studio to SAS Content Categorization Studio.

To upload your Category taxonomy, complete these steps:

1. Right-click on the Category Class node, in the ontology pane of the Classes tab and select Upload to SAS Content Categorization in the pop-up menu. The Category Uploading Wizard - Step 1 of 2: Specify a slot for category name appears.

![Category Class Uploading Wizard](image)

**Note:** If you upload this project more than once, subsequent Category Class Uploading Wizard Step 1 of 2 dialog boxes display the Slot name that you previously selected in the Slot for category name field.

2. (Optional) Click in the Language field and select a language. This drop-down menu is only available if you purchased more than one language and want to use another one of these languages for this project.
3. Click \( \text{Slot for category name} \) in the Slot for category name field and the Select a Slot dialog box appears.

4. Select a Slot. For more information, see Section 3.15.12 Use the Select a Slot Dialog Box on page 113.

5. Click OK.

6. (For UTF-8 languages only) Click \( \text{Slot for category display name} \) in the Slot for category display name field. See Step 3. on page 202.

7. Click Next and the Category Uploading Wizard - Step 2 of 2: Success dialog box appears.

8. Click Finish.

9. (Optional) Begin working with the uploaded taxonomy of Category Classes in SAS Content Categorization Studio.

### 6.3 Using the Entity Class Uploading Wizard

#### 6.3.1 Before You Upload the Entity Classes

Use the Entity Class Uploading Wizard to upload each of the Concepts that you created in SAS Ontology Management Studio, separately, to SAS Content Categorization Studio. Follow the steps below to upload one Class at a time and to specify the match (match_key) and information (returned_information) fields that together form the definitions for these
Classifier Concepts in SAS Content Categorization Studio. If you defined Boolean Concepts, specify the TGIF and TGULESS fields that specify how SAS Content Categorization Studio handles matches on these rules.

Before uploading each entity class, check to see that commas (,) are not used as separators in Slot values. If you specify a semicolon (;) as part of one or more Slot values and also select a semicolon as a separator character, each semicolon is replaced with a backslash followed by a semicolon (\;). Each backslash is replaced by two backslash characters (\\). Alternatively, if you choose another character as a separator character, only the backslash characters are replaced by two backslash characters.

### 6.3.2 Upload Entity Classes

To use the Entity Class Uploading Wizard, complete these steps:

1. Right-click on the Category Class node, in the ontology pane of the Classes tab and select the **Upload to SAS Content Categorization** from the pop-up menu that appears.

   The Class Uploading Wizard - Step 1 of 4: Set concept information dialog box appears.

2. (Optional) Click to select a Language if you purchased more than one language. The default selection is automatically entered.
3. (Optional) If you are building a project with a language that uses UTF-8 encoding, type the name that SAS Content Categorization Studio uses for the Concept name into the **Name (ASCII characters only)** field.

4. Click **Next**.
   The Class Uploading Wizard - Step 2 of 4: Specify fields mapping dialog box appears.

5. Click **** to choose a selection in the **Target fields** pop-up menu. Leave the default and recommended choice, **Match Field**, selected. For information about the other selections in this pop-up menu, see Section 3.13.2 **Class Uploading Wizard** on page 92.

6. Click **** to load all of the Slots into the pane below the **Slot** heading. For information about the other buttons in this pop-up menu, see Section 3.13.2 **Class Uploading Wizard** on page 92.
   
   Only one Slot can be designated as a **TGIF Field** or a **TGUNLESS Field**.

7. (Optional) When you choose to make multiple Slots **Info Fields**, click the **** and **** to specify the display order of these Slots.

8. Click **** and select **Info Fields**. Slot values from multiple **Info Fields** are joined using the pipe (|) character to form a single info
string for each Concept. The pipe character is similar to a space ( ) or comma (,) character, in the returned_information string for Classifier Concept definitions for SAS Content Categorization Studio.

9. Click **Next** and the Class Uploading Wizard - Step 3 of 4: Preview dialog box appears. By default, **Text view** is selected.

10. (Optional) Select **List view** to see these entries under the **Match Fields, Color, and Model Number** headings.
11. Click **Next** and the Class Uploading Wizard - Step 3 of 4: Preview dialog box appears.

12. Click **Finish**.
Reference Section

- Appendix A: _tstmgr Utility on page 209
- Appendix B: XML DTD File on page 219
- Appendix C: Teragram Regex Syntax on page 223
- Appendix D: Recommended Reading on page 227
- Appendix E: Glossary on page 229
Appendix: A
_tstmgr Utility

- Overview of the _tstmgr Utility
- Understanding _tstmgr Parameters
- Understanding Command Line Parameters
- Understanding Database Operations
- Understanding General Operations

A.1 Overview of the _tstmgr Utility

The _tstmgr utility is a command line program that complements and extends the functionalities of the SAS Ontology Management Studio user interface for Windows. This program is shipped in a package with a name that is similar to the example shown below:

_tstmgr_commandline.zip

You can download this zip file onto your computer and extract its files into the location of your choice.

Supported platforms for the _tstmgr utility include Windows and all major Unix distributions, for example, Linux, Solaris, and FreeBSD.

Two types of operations can be performed using _tstmgr. General functions that enable you to build SAS Ontology Management Studio projects and perform other operations that are not exposed in the user interface. Database functions, on the other hand, are used to manage the database required for SAS Ontology Management Studio and to perform various operations using content from this repository. Both of these types of operations are explained in detail in the following sections.
A.2 Understanding _tstmgr Parameters

In the subsections that follow this section of Appendix A, the syntax of the various operations for the _tstmgr command line are described:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;mysql_root_username&gt;</td>
<td>Specify the password set for the administrator with SQL server data source privileges. For more information, see Section 2.3 Installing and Configuring the Database Server on page 7.</td>
</tr>
<tr>
<td>&lt;mysql_root_username&gt;</td>
<td>Enter the user name of the administrator with SQL server data source privileges using this parameter. For more information, see Section 2.3 Installing and Configuring the Database Server on page 7.</td>
</tr>
<tr>
<td>&lt;odbc_driver_name&gt;</td>
<td>Specify the name of the ODBC data source that is used to connect to the database. For more information, see Section 2.5.3 Configuring Data Sources on page 12.</td>
</tr>
</tbody>
</table>

A.3 Understanding Command Line Parameters

An administrator, with server permissions, can perform the following operations that affect a SAS Ontology Management Studio project by using the command lines detailed in Section A.4 Understanding Database Operations on page 214 and Section A.5 Understanding General Operations on page 215.
Use the descriptions in Table A-2 below to understand the selections that you can choose for these database operations:

**Table A-2: Command Line Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-add_multiple database_support</td>
<td>Specify a different name for your database, or add another SAS Ontology Management Studio database to your server. For more information, see Section A.4.2 <em>Adding support for Multiple Databases</em> on page 214.</td>
</tr>
<tr>
<td>-add_user</td>
<td>Adds a user to the database. For more information, see Section 2.6.3 <em>Add Users</em> on page 21.</td>
</tr>
<tr>
<td>-admin -regular</td>
<td>Specify the following information:</td>
</tr>
<tr>
<td></td>
<td>-admin: This user is a SAS Ontology Management Studio project administrator.</td>
</tr>
<tr>
<td></td>
<td>-regular: This new user is a regular user for whom an administrator can set access privileges.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Section 2.6.3 <em>Add Users</em> on page 21.</td>
</tr>
<tr>
<td>-binary</td>
<td>This selection refers to the binary file .TSM.</td>
</tr>
<tr>
<td>-can_upload</td>
<td>If you specify -can_upload for a regular user, this user has permission to upload projects to the server. This developer effectively becomes a project administrator for the projects that she or he uploads. As a project administrator, this user can also change the permission levels of regular users. For more information, see Section 3.6 <em>Adding Users</em> on page 57.</td>
</tr>
<tr>
<td>-change_user</td>
<td>Change the specified permission level for this user. For example, you might want to change the user type to allow a regular user to become a project administrator. For more information, see Section A.5.1 <em>Changing User Types</em> on page 215.</td>
</tr>
<tr>
<td>-data</td>
<td>The path to the SAS Ontology Management Studio data directory is specified here.</td>
</tr>
<tr>
<td>-delete_user</td>
<td>Delete a user from the project. For more information, see Section A.5.2 <em>Deleting a User</em> on page 215.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-driver</td>
<td>Specify the name of the ODBC driver that you use to connect to the SAS Ontology Management Studio database.</td>
</tr>
<tr>
<td>-export_project</td>
<td>Export your project in either the default .xml format or the binary .TSM file format. For more information, see Section A.5.4 Exporting a Project on page 216.</td>
</tr>
<tr>
<td>-host host1</td>
<td>Specify hosts (either host names or IP addresses). Users can log in only from these locations. If you do not specify either a host name or an IP address, the developer can log in from any machine.</td>
</tr>
<tr>
<td>-host host2</td>
<td></td>
</tr>
<tr>
<td>-import_project</td>
<td>Import your exported SAS Ontology Management Studio project. For more information, see Section A.5.5 Importing a Project on page 217.</td>
</tr>
<tr>
<td>-initialize_database</td>
<td>Initialize the database that you are using for SAS Ontology Management Studio. For more information, see Section 3.5 Initializing the Database on page 57.</td>
</tr>
<tr>
<td>-list_classes</td>
<td>Return a list of all of the Classes in the specified project. For more information, see Section A.5.7 Listing Classes on page 217.</td>
</tr>
<tr>
<td>-list_projects</td>
<td>List all of the projects in the database. For more information, see Section A.5.6 Listing Projects on page 217.</td>
</tr>
<tr>
<td>-list_slots_of_project</td>
<td>Obtain a list of all of the Slots in a specified project. For more information, see Section A.5.8 Listing Slots on page 218.</td>
</tr>
<tr>
<td>-list_instances</td>
<td>Return the Instances for a specified Slot within the selected project. For more information, see Section A.5.9 Listing Instances on page 218.</td>
</tr>
<tr>
<td>-pass</td>
<td>Enter the password for the repository administrator.</td>
</tr>
<tr>
<td>-password</td>
<td>Type in the password for the user.</td>
</tr>
<tr>
<td>-project</td>
<td>Specify the path to the SAS Ontology Management Studio project for more information.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-reset_repository</td>
<td>Clear the database. For more information, see Section A.4.3 Resetting the Repository on page 215.</td>
</tr>
<tr>
<td>-show_users</td>
<td>Print a list of users with their permission levels by specifying this parameter. For more information, see Section A.5.3 Showing a List of Users on page 216.</td>
</tr>
<tr>
<td>-update</td>
<td>Update your database with the latest changes in the SAS Ontology Management Studio project.</td>
</tr>
<tr>
<td>-update_database</td>
<td>Commit changes to SAS Ontology Management Studio project to the repository. For more information, see Section A.4.1 Updating the SAS Ontology Management Studio Database on page 214 for more information.</td>
</tr>
<tr>
<td>-user</td>
<td>Enter the administrative user name.</td>
</tr>
<tr>
<td>-username</td>
<td>Specify the name of a user as it appears on the server.</td>
</tr>
<tr>
<td>-verbose</td>
<td>Run SAS Ontology Management Studio in verbose mode.</td>
</tr>
</tbody>
</table>

**Note:** Selections that are enclosed in brackets ([ ]) are optional.
A.4 Understanding Database Operations

A.4.1 Updating the SAS Ontology Management Studio Database

Periodically, the database schema and table contents are updated and these new features are added to SAS Ontology Management Studio. In order to gain the benefits of these updates, without losing any of your existing data, you should specify the following command line:

\[_tstmgr -update_database
    -driver odbc_driver_name
    -user root_name
    [-pass root_password]\]

For more information, see the \[-update_database\] parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 \_tstmgr Parameters on page 210.

A.4.2 Adding support for Multiple Databases

By default, the SAS Ontology Management Studio database is named tstmdb. If you want to use a different name, or if you want to add another SAS Ontology Management Studio database to the server, use the following SAS command line:

\[_tstmgr -add_multiple_database_support
    -driver odbc_driver_name
    -user root_name
    [-pass root_password]\]

For more information, see the \[-add_multiple_database_support\] parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 \_tstmgr Parameters on page 210.
A.4.3 Resetting the Repository

You, as the database administrator, can use the following command line to clear out the entire database:

```bash
_tstmgr -reset_repository
    -driver odbc_driver_name
    -user root_name
    [-pass root_password]
```

For more information, see the `-reset_repository` parameter in Table A-2 `Command Line Parameters` on page 211 and Table A-1 `_tstmgr Parameters` on page 210.

A.5 Understanding General Operations

A.5.1 Changing User Types

You, as the administrator, can use the following command line to change the type of user. For example, make a regular user a project administrator.

```bash
_tstmgr -change_user
    -driver <odbc_driver_name>
    -user root [-pass pass]
    -username newuser
    -admin|-regular
```

For more information, see the `-change_user` parameter in Table A-2 `Command Line Parameters` on page 211 and Table A-1 `_tstmgr Parameters` on page 210.

A.5.2 Deleting a User

An administrator can use the following command line to delete a user from the project:

```bash
_tstmgr -delete_user
    -driver <odbc_driver_name>
    -user root
```
[-pass pass]
-username newuser

For more information, see the -delete user parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 _tstmgr Parameters on page 210.

A.5.3 Showing a List of Users

You can use the following command line to print a list of users and their permission levels:

_tstmgr -show_users
   -driver odbc_driver_name
   -user root
   [-pass pass]

For more information, see the -show users parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 _tstmgr Parameters on page 210.

A.5.4 Exporting a Project

Use the following command line to export a project in either the default .xml file format or by specifying .TSM. This is the binary file format that is recommended for large projects:

_tstmgr -export_project
   -driver odbc_driver_name
   -user user_name
   -pass user_password
   -project project_name
   -file file_name
   [-binary]

For more information, see the -export project parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 _tstmgr Parameters on page 210.
A.5.5 Importing a Project

You can use the following command line to import a SAS Ontology Management Studio project that was exported in either the default .xml file format or the binary file format .TSM. The .TSM format is recommended for large projects:

```
_tstmgr -import_project
    -driver odbc_driver_name
    -user user_name
    -pass user_password
    -project project_name
    -file file_name
    [-binary]
```

For more information, see the `import_project` parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 _tstmgr Parameters on page 210.

A.5.6 Listing Projects

Use the following command line to list the SAS Ontology Management Studio projects in your database:

```
_tstmgr -list_projects
    -driver odbc_driver_name
    -user user_name
    -pass user_password
```

For more information, see the `list_projects` parameter in Table A-2 Command Line Parameters on page 211 and Table A-1 _tstmgr Parameters on page 210.

A.5.7 Listing Classes

Use the following command line to list all of the Classes in the specified SAS Ontology Management Studio project:

```
_tstmgr -list_classes
    -driver odbc_driver_name
    -user user_name
    -pass user_password
    -project project_name
```
For more information, see the `-list_classes` parameter in Table A-2
`Command Line Parameters` on page 211 and Table A-1 `_tstmgr Parameters` on page 210.

A.5.8 Listing Slots

Use the following command line to list all of the Slots in the specified SAS Ontology Management Studio project:

```
_tstmgr -list_slots_of_project
  -driver odbc_driver_name
  -user user_name
  -pass user_password
  -project project_name
```

For more information, see the `-list_slots_of_project` parameter in Table A-2 `Command Line Parameters` on page 211 and Table A-1 `_tstmgr Parameters` on page 210.

A.5.9 Listing Instances

Use the following command line to list all of the Instances within the Class of a specified SAS Ontology Management Studio project:

```
_tstmgr -list_instances
  -driver odbc_driver_name
  -user user_name
  -pass user_password
  -project project_name
  -class class_name
```

For more information, see the `-list_instances` parameter in Table A-2 `Command Line Parameters` on page 211 and Table A-1 `_tstmgr Parameters` on page 210.
Appendix: B
XML DTD File

B.1 Overview of the XML DTD File

The ontologies of both Categories and Concepts can be defined in .xml format. Use this appendix as a reference to interpret and write your own XML file. The advantage of using XML to define taxonomies is that XML files can be used on a variety of hardware and software platforms, making them machine-independent.

An example of a .xml file, with defined elements, for Category ontologies is provided in Section B.2.2 Understanding XML Taxonomy Format for Ontologies on page 220.

B.2 What is the Categorization Class XML File Format?

The categorizer in SAS Ontology Management Studio is defined by an XML file that can be named:

   <language>.directory.xml

where <language> is the language represented by the specified Categorizer, for example, English.directory.xml. However, you can choose to name this file whatever you choose.
B.2.1 Understanding Language Encoding Specifications

Every ontology XML file begins with the two lines in Example B-1 below:

*Example B-1: The First Two Lines of the Categorization XML File*

```xml
<?xml version="1.0" encoding="ISO-8859-1"?>
TstmgrClassInstancesStructureV1
```

However, the first line in Example B-1 above should be substituted with the following line of code when the language that is represented by this Categorizer is a UTF-8 language. For example, use this code with Russian, Middle Eastern, or Asian languages:

```xml
<?xml version="1.0" encoding="UTF-8"?>
```

B.2.2 Understanding XML Taxonomy Format for Ontologies

The tags listed in this section are specified in the file immediately following the two lines displayed in Example B-1 above. All of these tags are optional. In other words, if these tags are not specified, the default settings for the categorization ontology are used. When specified, these tags affect the entire project. The tags that are listed below should retain the specified format when they are used in the Categorization XML file. Any exceptions to this rule are cited in the relevant description of the specified tag.

The XML files that define ontologies are named `language.directory.xml` (where `language` is the expected language, such as Chinese, Japanese, or Russian, of the input document). The format of the ontologies XML taxonomy file is shown in Example B-2 below:

*Example B-2: XML Format for Category Taxonomy*

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!ELEMENT TstmgrClassInstancesStructureV1 (Class,Instances)>  
<!ELEMENT Class (#PCDATA)>  
<!ELEMENT Instances (Instance*)>  
<!ELEMENT Instance (Slot+)>  
<!ELEMENT Slot (#PCDATA)>  
```
Table B-1 below lists the XML elements with their descriptions followed by a list of attributes with their project locations.

<table>
<thead>
<tr>
<th>XML Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TstmgrClassInstances</td>
<td>Specify the root element of the Teragram XML format.</td>
</tr>
<tr>
<td>StructureV1</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Specify the Class name.</td>
</tr>
<tr>
<td>Instances</td>
<td>List all of the Instances of the specified Class.</td>
</tr>
<tr>
<td>Instance</td>
<td>Return each Instance within the specified Slot.</td>
</tr>
<tr>
<td>Slot</td>
<td>Name the Slot.</td>
</tr>
</tbody>
</table>

For each Slot, the following character data is returned:

<table>
<thead>
<tr>
<th>Class name</th>
<th>(Required) Return the name of the Class as it is entered into the Class Name field in the Classes tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance nameid</td>
<td>(Required) Return the unique instance name that is entered into the Instance Name field of the Instances tab.</td>
</tr>
<tr>
<td>Instance iid</td>
<td>(Required) Return the unique instance identification that is entered into the ID field that is required for each instance.</td>
</tr>
<tr>
<td>Slot name</td>
<td>(Required) Return the name of the Slot as it is entered into the Slot Name field in the Slots tab.</td>
</tr>
<tr>
<td>Slot value</td>
<td>(Required) Refers to the Value Type field for each Slot in the Slots tab.</td>
</tr>
</tbody>
</table>
Appendix: C
Teragram Regex Syntax

- What Rules and Restrictions Apply to Teragram Regular Expressions?
- Special Characters
- Special Cases

C.1 What Rules and Restrictions Apply to Teragram Regular Expressions?

The following rules and restrictions apply to Teragram regular expressions:

- Any single character \texttt{a} (ASCII 1 through 252, subject to escaping restrictions in 14 below) is a regular expression, and it matches precisely that character.

- If \texttt{a} and \texttt{b} are regular expressions, then so is \texttt{ab} that matches whatever \texttt{a} matches followed by whatever \texttt{b} matches (concatenation).

- If \texttt{a} and \texttt{b} are regular expressions, then so is \texttt{a|b} that matches either whatever \texttt{a} matches or whatever \texttt{b} matches.

- If \texttt{a} is a regular expression, then so is \texttt{(?:a)} that simply serves as a grouping mechanism without remembering what it was grouping. For example, \texttt{(?:ababb)|b} would match either \texttt{abaab} or \texttt{b} that would be difficult to express without the grouping mechanism.

- A character class is a regular expression. One or more characters inside square brackets (\texttt{[ ]})—for example, \texttt{[abc]} matches any of the characters inside. A range inside a character class, \texttt{a-z}—for example, matches any ASCII character whose value is between \texttt{a} and \texttt{z}, inclusive. Any character can appear in a character class; however, \texttt{\} (backslash), \texttt{-} (hyphen), and \texttt{]} (close bracket) is preceded by a backslash, and \texttt{^} (carat) is preceded by a backslash if it is the first character in the character class.
- A negated character class is a regular expression. One or more characters are inside square brackets, with ^ (carat) being the first character to indicate negation. For example, [^abc] matches any character except a, b, or c.

- If a is a regular expression, then so is a* that matches 0 or more occurrences of whatever a matches.

- If a is a regular expression, then so is a+ that matches 1 or more occurrences of whatever a matches.

- If a is a regular expression, then so is a? that matches 0 or 1 occurrences of whatever a matches.

- If a is a regular expression, then so is a{n,m} that matches at least n but no more than m concatenated occurrences of whatever a matches.

- If a is a regular expression, then so is a{n,} that matches at least n concatenated occurrences of whatever a matches.

- If a is a regular expression, then so is a(n) that matches exactly n concatenated occurrences of whatever a matches.

- If filename is the name of a file containing the binary representation of a sub-expression a, then the syntax (?$filename) will insert that sub-expression into the current regular expression. To create such a file, use the _treg utility as follows:

  _treg -to_fso 'a' >filename
### C.2 Special Characters

Table C-1 lists and gives extended meaning for special characters with Teragram regular expressions.

**Table C-1: Special Characters in Teragram Regular Expressions**

<table>
<thead>
<tr>
<th>Character</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>\a</td>
<td>Alarm (beep)</td>
</tr>
<tr>
<td>\n</td>
<td>Newline</td>
</tr>
<tr>
<td>\r</td>
<td>Carriage return</td>
</tr>
<tr>
<td>\t</td>
<td>Tab</td>
</tr>
<tr>
<td>\f</td>
<td>Form feed</td>
</tr>
<tr>
<td>\e</td>
<td>Escape</td>
</tr>
<tr>
<td>\d</td>
<td>Digit (same as [0-9])</td>
</tr>
<tr>
<td>\D</td>
<td>Not a digit (same as [^0-9])</td>
</tr>
<tr>
<td>\w</td>
<td>Word character (same as [a-zA-Z_0-9])</td>
</tr>
<tr>
<td>\W</td>
<td>Non-word character (same as [^a-zA-Z_0-9])</td>
</tr>
<tr>
<td>\s</td>
<td>Whitespace character (same as [\t\n\r\f])</td>
</tr>
<tr>
<td>\S</td>
<td>Non-whitespace character (same as [^\t\n\r\f])</td>
</tr>
<tr>
<td>.</td>
<td>Wildcard (matches any character)</td>
</tr>
<tr>
<td>\xh</td>
<td>Hexidecimal number, where h is a hexidecimal digit</td>
</tr>
<tr>
<td>\xhh</td>
<td>Hexidecimal number, where hh is a hexidecimal digit</td>
</tr>
<tr>
<td>0o</td>
<td>Octal number, where o is an octal digit</td>
</tr>
<tr>
<td>0oo</td>
<td>Octal number, where oo is an octal digit</td>
</tr>
</tbody>
</table>
C.3 Special Cases

There are four special cases for Teragram regular expressions. These are:

1. For metacharacters such as [,.)(?*,+\-, to have literal meaning, they need to be escaped with a backslash (\). If inside a character class, however, only those mentioned explicitly need escaping.

2. No support is provided for backward references or () as a remembering grouping mechanism.

3. No support is provided for ^ as the beginning-of-line, zero-width assertion, or $ as the end-of-line, zero-width assertion. Unlike Perl regular expressions, both of these markers are implicitly assumed.

4. ASCII values 0, 253, 254, and 255 are reserved characters that cannot be used in Teragram regular expressions. Regular expressions work only on single-byte characters.
Appendix: D  
Recommended Reading

The following books are recommended as companion guides:

- **SAS Content Categorization Studio: User's Guide**: Create a SAS Content Categorization Studio project, test, and upload to Teragram CatCon Server.

- **SAS Content Categorization Collaborative Server: User’s Guide**: Enable multiple subject matter experts to work together on one SAS Content Categorization Studio project.

- **SAS Content Categorization Server: Administrator and Java Programmer’s Guide**: Understand how Teragram CatCon Server applies the `.mco` and `.concepts` files to input documents. Program this application using the Java language.

- **SAS Content Categorization Server: Administrator and C Programmer’s Guide**: Understand how Teragram CatCon Server applies the `.mco` and `.concepts` files to input documents. Program this application using the C language.

- SAS offers instructor-led training and self-paced e-learning courses to help you get started with the SAS add-in, learn how the SAS add-in works with the other products in the SAS Enterprise Intelligence Platform, and learn how to run stored processes in the SAS add-in. For more information about the courses available, see support.sas.com/training.

For a complete list of SAS publications, see the current SAS Publishing Catalog. To order the most current publications or to receive a free copy of the catalog, contact a SAS representative at

SAS Publishing Sales  
SAS Campus Drive  
Cary, NC 27513  
Telephone: (800) 727-3228*  
Fax: (919) 677-8166  
E-mail: sasbook@sas.com  
Web address: support.sas.com/pubs
* For other SAS Institute business, call (919) 677-8000.

Customers outside the United States should contact their local SAS office.
Appendix: E
Glossary

Abstract
makes a Class noninstantiable. In other words, no Instances can be created for this Class. Use this selection when you want to define Slots that apply to all of the subclasses of this Class or to limit Instances to the subclasses of the selected Class.

Class
a group of objects, for example, rivers, paint, cars, or baseball teams.

Constraint
sets the type of value that limits a Slot, for example, multiple cardinality, maximum length, or unique. Also see Slots.

Default user permissions
specify at the Class and Instance levels for other developers and editors who work on this project.

Domain
specify Class memberships for the selected Slot, when the Classes that this Slot is assigned to constrain do not have parent-child relationships.

Export
download a copy of the SAS Ontology Management Studio project from the repository to a local machine.

Import
upload the copy of the SAS Ontology Management Studio project to the repository.

Instances
define specific objects within a Class. For example, when used with the Paint Class specific instantiations might include, Sherwin Williams, sunset orange, oil paint; Ralph Lauren, golden brown, and latex paint.
**Metadata**
a superset of data, or data on information. Metadata determines what type of information is important when defining instantiations of a specific Class.

**Ontology**
a classification system, like a taxonomy, of the metadata on information.

**Project Administrator**
can add or delete users or groups from the project and set the permission level for individuals as well as groups of users.

**Regular users**
the subject matter experts that contribute to a project based on the permission level granted by a administrator.

**Slot**
the metadata attributes that are assigned to each Class. For example, when used with the *Paint* Class, sample Slots could include brand, color, and type. Metadata differentiate ontology management from taxonomy management.

**Taxonomy**
an organized classification structure for the Categories and Concepts that define information.
Index

.csv file
- import ................................................................. 90
- import or export .................................................. 88
.tsv
- .xml ................................................................. 136
- binary file format ................................................ 136
.xml file
- export Instances .................................................. 88
- import ................................................................. 90
- import or export .................................................. 88
- import project ..................................................... 35
- usage ................................................................. 124
_tstmgr
- Linux installation kit ........................................... 6
_tstmgr utility
- defined ............................................................... 10
- tstmgr_commandline.zip ...................................... 10
_tstmgr.exe
- Windows installation kit ...................................... 6

A

About
- Help ................................................................. 37
Abstract field
- Instances ......................................................... 42, 160
Add a Constraint dialog box
- usage ............................................................... 180, 181, 184, 185
- User/Group field .............................................. 116
Add a Constraint window
- available options ............................................. 51
- Constraint ......................................................... 107
- Multiple Cardinality ......................................... 178
- open ................................................................. 107
- Value field ....................................................... 107
- Value Type settings .......................................... 107
Add a Slot window
  Author ................................................................. 157
  Constraints ............................................................ 158
  Create button ............................................................ 43
  Default Permission ..................................................... 157
  Description ............................................................. 158
  Domain ................................................................. 158
  fields defined ......................................................... 43, 45
  usage ................................................................. 45, 186, 187, 189
  Value Type ............................................................. 158
Add a Value dialog box
  Select a value from the list ........................................... 123
Add or Remove Programs
  uninstall Teragram Semantic Term Manager ....................... 27
Add Slot
  usage ................................................................. 114
Add slots and add/delete/modify existing instances
  permission defined ..................................................... 41
add user
  syntax ................................................................. 21
Add, delete and modify instances
  permission defined ..................................................... 149, 154
Add, delete and modify instances and slots
  permission defined ..................................................... 149, 154
Add/delete and modify existing instances
  permission defined ..................................................... 41, 149, 154
-add_multiple_database_support
  defined ................................................................. 211
-add_multiple_database_support
  command line .......................................................... 214
-add_user
  command line .......................................................... 21
  defined ................................................................. 22, 211
adding users
  command line .......................................................... 21
  credentials ............................................................ 21
-admin
  defined ................................................................. 22
  option defined ........................................................ 211
Administrative privilege
  defined ................................................................. 148
User Management - Groups window ..................................... 84
Administrator
   access permissions ................................................................. 133
   New Group window .............................................................. 85
   permission defined ............................................................. 148
   privilege .................................................................................. 132
All
   permission defined ............................................................. 42, 50, 149, 150, 154, 158
Allow editing inherited slots in sub-classes
   disable ..................................................................................... 115
   usage .......................................................................................... 75
Allowed Class
   Constraint option .............................................................. 110, 111, 112, 168, 177
   Recursive .................................................................................. 168, 177
   usage .......................................................................................... 65
Always reconnect on ODBC timeout
   usage .......................................................................................... 73
Author
   Add a Slot window ............................................................. 157
   Classes window ........................................................................ 41
   usage .......................................................................................... 41, 49

B

Begin recording debugging info in log file after restarting STM
   usage .......................................................................................... 72
Begins with
   Condition .................................................................................. 68, 194
Binary
   File Type .................................................................................. 78, 80
   -binary
defined ..................................................................................... 211
   blank field
   Instances window ...................................................................... 59
Boolean
   Constraint option ...................................................................... 111
   Value Type .................................................................................. 52
Boolean rule
   Constraint .................................................................................. 109
-can_upload ........................................................................................................... 22, 211
  defined .............................................................................................................. 22, 211
Candidate
  Constraint option .......................................................................................... 109, 111, 179
  Multiple Cardinality ....................................................................................... 178
  Value field ...................................................................................................... 111
Case Insensitive button
  usage .................................................................................................................. 60
Case Sensitive
  Queries interface .............................................................................................. 69
Case Sensitive button
  usage .................................................................................................................. 60
categorization
  XML taxonomy files ......................................................................................... 220
Change Password window
  usage .................................................................................................................. 104
  User name .......................................................................................................... 104
-change_user
  command line ..................................................................................................... 215
  defined ................................................................................................................ 211
check box
  Queries interface ............................................................................................... 68
Class
  defined ................................................................................................................ 146
  Queries interface ............................................................................................... 68
Class Editor section
  Classes window ................................................................................................. 40
Class ID
  Value Type ........................................................................................................ 52, 167, 179
Class Name field
  Classes window ................................................................................................. 40
Classes
  defined ................................................................................................................ 38
  permissions ......................................................................................................... 147
  privileges ........................................................................................................... 149, 150
  Slots .................................................................................................................... 46
Classes tab
  Default Class Permission .................................................................................. 154
Classes window
  Author field ....................................................................................................... 41
<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to DB</td>
</tr>
<tr>
<td>File</td>
</tr>
<tr>
<td>option</td>
</tr>
<tr>
<td>Connector/ODBC window</td>
</tr>
<tr>
<td>usage</td>
</tr>
<tr>
<td>Consistency Check</td>
</tr>
<tr>
<td>usage</td>
</tr>
<tr>
<td>Constraint</td>
</tr>
<tr>
<td>Add a Constraint window</td>
</tr>
<tr>
<td>Unique</td>
</tr>
<tr>
<td>Constraint option</td>
</tr>
<tr>
<td>Allowed Class</td>
</tr>
<tr>
<td>Boolean</td>
</tr>
<tr>
<td>Boolean rule</td>
</tr>
<tr>
<td>Candidate</td>
</tr>
<tr>
<td>Default</td>
</tr>
<tr>
<td>Hierarchy Element</td>
</tr>
<tr>
<td>Identifier</td>
</tr>
<tr>
<td>Instance Of</td>
</tr>
<tr>
<td>Inverse</td>
</tr>
<tr>
<td>Maximum</td>
</tr>
<tr>
<td>Maximum Length</td>
</tr>
<tr>
<td>Minimum</td>
</tr>
<tr>
<td>Multiple Cardinality</td>
</tr>
<tr>
<td>Not NULL</td>
</tr>
<tr>
<td>Recursive</td>
</tr>
<tr>
<td>Regular Expression</td>
</tr>
<tr>
<td>Unique</td>
</tr>
<tr>
<td>Constraints</td>
</tr>
<tr>
<td>Add a Slot window</td>
</tr>
<tr>
<td>options</td>
</tr>
<tr>
<td>Constraints heading</td>
</tr>
<tr>
<td>Slots window</td>
</tr>
<tr>
<td>Contains</td>
</tr>
<tr>
<td>Condition</td>
</tr>
<tr>
<td>CPU</td>
</tr>
<tr>
<td>Create a Value window</td>
</tr>
<tr>
<td>Enter a string</td>
</tr>
<tr>
<td>Instance Editor section</td>
</tr>
<tr>
<td>usage</td>
</tr>
</tbody>
</table>
Create button
Add a Slot window .................................................................................. 43
Slot ........................................................................................................... 156
usage ....................................................................................................... 43, 60
create data sources
credentials ............................................................................................ 12
Create New Data Source window
open ........................................................................................................... 16
usage ........................................................................................................... 16
Create Slot button
operable fields ....................................................................................... 47
Create Subclass
usage ....................................................................................................... 39
Creator heading
Project List heading ................................................................................ 99
credentials
adding users .......................................................................................... 21
create data sources .................................................................................. 12
initialize database .................................................................................. 19
third data source ..................................................................................... 23

D
-d switch
usage ....................................................................................................... 24
-data
defined ................................................................................................... 211
data source name
connect to database ................................................................................ 28
Connector/ODBC window ........................................................................ 17
repository login ....................................................................................... 28
Database
defined .................................................................................................. 14
database administrator
root password ........................................................................................ 21
-database option
defined .................................................................................................. 20
Default
Constraint option ..................................................................................... 109, 112, 165
Default Class Permission
Classes tab ................................................................................................ 154
Classes window .......................................................... 41
drop-down list .......................................................... 41
Default Constraint
  set ............................................................................. 165
default option
  Condition ............................................................. 194
Default Permission
  Add a Slot window ............................................... 157
drop-down list ........................................................ 51
default user permissions
  defined ..................................................................... 38
Delete button
  Open Project window ............................................ 100
  -delete_user
    command line ....................................................... 216
defined ................................................................. 211
Description
  Add a Slot window ............................................... 158
  Connector/ODBC window ..................................... 17
  New Group window ............................................. 85
  User Management - Groups window ..................... 84
Description field
defined ................................................................... 42, 52
Details button
  Connector/ODBC window ..................................... 18
Disconnect
  File ......................................................................... 36
Disconnect button
  usage ....................................................................... 37
Does not contain
  Condition .......................................................... 69, 195
Domain
  Add a Slot window ............................................... 158
defined ................................................................. 190
  Remove button ..................................................... 53
  Slots window ....................................................... 53
Driver
defined ..................................................................... 14
  -driver
    defined ................................................................... 22
  -driver option
defined ................................................................... 20, 212
<table>
<thead>
<tr>
<th><strong>E</strong></th>
</tr>
</thead>
</table>
| **Edit button**  
  usage ................................................................................................................114 |
| **Edit Slot window**  
  Slot Editor section .............................................................................................49  
  usage ................................................................................................................114 |
| **Edit Value window**  
  access ...............................................................................................................114  
  usage ................................................................................................................115 |
| **ellipses button**  
  Save As window ..............................................................................................138  
  Value field .......................................................................................................111 |
| **Ends with**  
  Condition ................................................................................................... 68, 194 |
| **Enter a new name field**  
  usage ................................................................................................................101 |
| **Enter a string**  
  Create a Value window ...................................................................................122 |
| **Entity Class**  
  Classifier Concepts ..........................................................................................146  
  executable .................................................................................................................24 |
| **Teragram Semantic Term Manager** ................................................................6 |
| **Exit**  
  File .....................................................................................................................36 |
| **Expand**  
  usage ............................................................................................................ 40, 58 |
| **Export**  
  File .....................................................................................................................35, 137  
  export a project ..................................................................................................136  
  subclass relationships ......................................................................................146 |
| **Export button**  
  Export Project Wizard .....................................................................................100  
  Open Project window .......................................................................................100 |
| **Export Instances**  
  usage ..................................................................................................................58 |
| **Export Project Wizard**  
  Export button ...................................................................................................100  
  File Type .........................................................................................................78, 80  
  open .................................................................................................................78, 79, 80, 100  
  Where to store exported project file? field .........................................................78 |
Export Project Wizard Step 1
  open ................................................................. 137
Export Project Wizard Step 2
  open ................................................................. 137
  -export_project
    command line ......................................................... 216
    defined .............................................................. 212

F

Fewer Queries interface ............................................................... 69
File
  Export ................................................................. 137
  Import ................................................................. 139
File name
  Save As window .......................................................... 124
File Type
  Export Project Wizard .................................................... 78, 80
  filename ........................................................................ 224
  first button
    usage ................................................................. 61, 66, 129
Float
  Value Type .................................................................. 52

G

Group name
  New Group window ..................................................... 85
Group Properties window
  usage .......................................................................... 86
  groups
    define ................................................................. 148
  User Management window ............................................. 148
**H**

Hierarchy Element
- Constraint option ............................................................... 110, 170
- Instance Of .......................................................................... 170
- Recursive ........................................................................... 170
- usage .................................................................................. 65
- Value .................................................................................. 110
- host
  - defined ............................................................................. 212
  - options defined .............................................................. 22
- hosts
  - specify ............................................................................... 22, 212

**I**

icons
- standard toolbar ............................................................... 37
Identifier
- Constraint option ............................................................... 110, 188
Import
- File ...................................................................................... 35, 139
import
- .xml file ................................................................................ 77
- project .................................................................................. 77
Import button
- Import Project Wizard ...................................................... 100
- Open Project window ....................................................... 100
Import Instance
- usage ................................................................................... 58
Import Project Wizard
- Import button ................................................................. 100
  open .................................................................................. 100, 139, 140
- Project file field .............................................................. 80
- Step 1 window .................................................................. 139
- Step 2 window .............................................................. 139
- Step 3 window .............................................................. 140
Import Project Wizard Step 1
  open .................................................................................. 139
Import Project Wizard Step 2
  usage .................................................................................... 139
Instance status
   Inactive deleted ................................................................. 63
   Inactive disabled ............................................................. 63
   Inactive proposed ............................................................ 63
   Inactive rejected ............................................................... 63

Instances
   Abstract field ................................................................. 160

Instances section
   usage ................................................................. 59

Instances tab
   Queries tab ................................................................. 196

Instances window
   blank field ................................................................. 59

Integer
   Value Type ................................................................. 51

interface
   blank ................................................................. 132
   components ............................................................. 34, 132

Inverse
   Constraint option ........................................................ 110, 173

Is
   Condition ................................................................. 68, 194

Is not
   Condition ................................................................. 68, 194

Is Not NULL
   Condition ................................................................. 69, 195

Is NULL
   Condition ................................................................. 69, 195

last button
   usage ................................................................. 61, 66, 129

-list_classes
   command line ................................................................. 218
   defined ................................................................. 212

-list_instances
   command line ................................................................. 218
   defined ................................................................. 212
-list_projects
  command line .................................................................................................. 217
defined ........................................................................................................ 212, 217, 218
-list_slots_of_project
  command line .................................................................................................. 218
defined ........................................................................................................ 212
local machine
  export project .................................................................................................. 136
Log file field
  usage ................................................................................................................ 73
log in
  information .................................................................................................. 28

M
 Maintenance
  usage ................................................................................................................. 58
 Match All
   Queries interface .............................................................................................. 69
   usage ............................................................................................................... 195
 Match Any
   Queries interface .............................................................................................. 69
   usage ............................................................................................................... 195
 Match string
   Classifier Concepts ......................................................................................... 94, 204
 max_allowed_packet
   change ............................................................................................................. 9
 Maximum
   Constraint option .............................................................................................. 109, 111, 185
 Maximum Length
   Constraint option .............................................................................................. 109, 185
 Members
   New Group window .......................................................................................... 86
 Menu bar
   location ............................................................................................................. 35
 Menu button
   usage .............................................................................................................. 60
 metadata
   Slots ............................................................................................................... 156
 Minimum
   Constraint option .............................................................................................. 109, 111, 185
new project
open .......................................................... 135

New Project window
New button .......................................................... 135
open .......................................................... 100
usage .......................................................... 101, 135

New User window
usage .......................................................... 103

next button
usage .......................................................... 61, 66, 129

Not NULL
Constraint option .......................................................... 110
Value .......................................................... 110

ODBC Data Source Administrator window
open .......................................................... 15

ODBC data sources
3 types .......................................................... 10

ODBC drivers
install .......................................................... 11

odbc.ini file
usage .......................................................... 13

ontology
build .......................................................... 145, 146

ontology of Instances
Teragram TK240 .......................................................... 170

ontology section
usage .......................................................... 39

Open
File .......................................................... 35, 99

Open Project window
Delete button .......................................................... 100
Export button .......................................................... 100
Import button .......................................................... 100
New button .......................................................... 100
Project List field .......................................................... 99
Rename button ................................................................. 100
usage .................................................................................. 99, 134
operating systems
supported ................................................................................ 7

P

-pass
defined .................................................................................. 22
option .................................................................................. 20, 212
Password
Connector/ODBC window .................................................. 18
User Management - Users window ........................................ 83
-password
defined .................................................................................. 22, 212
password
connect to database ............................................................... 28
Password field
usage .................................................................................. 98, 133
passwords
User Management window ................................................... 148
Permission Editor window
access .................................................................................. 116
open .................................................................................. 40
Set Permission ........................................................................ 40
usage .................................................................................. 58, 115, 151
permissions
interrelationship .................................................................. 151
levels .................................................................................. 148
Port
Connector/ODBC window ................................................... 17
defined .................................................................................. 14
Preferences
cache option ........................................................................ 29
Edit .................................................................................. 36
Preferences button
usage .................................................................................. 37
Preferences window
set options ............................................................................ 72
usage .................................................................................. 29
previous button
    usage .......................................................... 61, 66, 129
print
    user list .................................................. 216
Privilege
    User Management - Groups dialog box ...................... 84
    User Management - Users window ............................. 83
Program and Project title bar
    defined ....................................................... 34
    -project
        option ...................................................... 212
project
    import ..................................................... 77, 138
    save .......................................................... 138
project administrator
    defined ........................................................ 21
Project file
    Export Project Wizard ......................................... 80
    usage ......................................................... 80
Project file field
    usage .......................................................... 139
Project List field
    Open Project window ......................................... 99
Project List heading
    Creator heading ............................................... 99
    Project Name heading ......................................... 99
project name
title bar ........................................................... 34
Project name field
    usage .......................................................... 101, 135
Project Name heading
    Project List heading ......................................... 99
Project windows
    defined ....................................................... 35
Prompt for update when leaving window with unsaved data
    usage .......................................................... 76
Q

Queries interface
  Case Sensitive ................................................................. 69
  check box ........................................................................... 68
  Class .................................................................................. 68
  Clear button ........................................................................ 69
  Fewer .................................................................................. 69
  Match All ............................................................................ 69
  Match Any .......................................................................... 69
  More button ......................................................................... 69
  open ..................................................................................... 193
  Replace ................................................................................ 70
  Search Results ..................................................................... 70
  Slot ...................................................................................... 68
  String ................................................................................ 69
  usage .................................................................................. 67, 192

Queries tab
  Instances tab ....................................................................... 196

R

RAM ....................................................................................... 7
Read only
  permission defined ......................................................... 41, 50, 149, 150, 154, 157
Recursive
  Allowed Class ...................................................................... 168, 177
  Constraint option .............................................................. 110, 177
  Hierarchy Element ............................................................ 170
  Value .................................................................................... 110

referred Instances
  Warning window ................................................................. 128

-regular
  defined ............................................................................. 22, 211

Regular Expression
  Constraint option .............................................................. 110, 183

regular user
  command line ...................................................................... 21
  defined .............................................................................. 148
  permissions ........................................................................ 147
Remember box
  usage ................................................................. 98, 133
Remove All button
  usage ................................................................. 60
Remove button
  usage ................................................................. 60
Rename button
  Open Project window ........................................ 100
  open Rename Project window .............................. 100
Rename Project window
  open ................................................................. 100
  usage ................................................................. 101
Replace button
  Queries interface ................................................ 70
  usage ................................................................. 196
  replace operation
    usage ................................................................. 192
  replace results
    Search Results pane ................................. 196
Replace window
  usage ................................................................. 105
  repository
    connect ............................................................. 132
    remote ............................................................. 28
    reset ................................................................. 148
    Reset option ...................................................... 36, 102
Repository field
  usage ................................................................. 98, 133
Repository Login button
  usage ................................................................. 37
Repository Login window
  open ................................................................. 98
  relation to UI ....................................................... 32
  usage ................................................................. 133
  User Name field .............................................. 41
Reset option
  repository .......................................................... 36, 102
  -reset_repository
    command line .................................................. 215
    option ............................................................. 213
Revert Class To Older
usage ................................................................. 58
root password
database administrator ..................................... 21

S

Save as type
Save As window .................................................. 124
Save As window
ellipsis button ...................................................... 138
File name .......................................................... 124
open ................................................................. 138
Save as type ....................................................... 124
usage ............................................................... 125
Search button
usage ............................................................... 60, 66
Search Results
compare .............................................................. 197
Queries interface ................................................. 70
Search Results pane
replacement results ............................................. 196
Select a Class window
usage .......................................................... 112, 168, 169
Select a value from the list
Add a Value dialog box ......................................... 123
Select Groups/Users window
usage ............................................................... 117, 152
Select Items dialog box
usage ............................................................... 196
Select Items window
open ............................................................... 118, 190, 193, 194
usage ............................................................... 118
Select Slots window
open ............................................................... 113
usage ............................................................... 113
Server
Connector/ODBC window .................................. 17
defined .......................................................... 14
server administrator
sender password .............................................. 21
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>server configuration</td>
<td></td>
</tr>
<tr>
<td>change data size</td>
<td>8, 9</td>
</tr>
<tr>
<td>Set Display Slot window</td>
<td></td>
</tr>
<tr>
<td>usage</td>
<td>60, 119</td>
</tr>
<tr>
<td>Set Permission</td>
<td></td>
</tr>
<tr>
<td>drop-down Class option</td>
<td>151</td>
</tr>
<tr>
<td>Permission Editor window</td>
<td>40</td>
</tr>
<tr>
<td>usage</td>
<td>40, 58</td>
</tr>
<tr>
<td>Set Permission window</td>
<td></td>
</tr>
<tr>
<td>Slot &amp; Class permissions</td>
<td>51</td>
</tr>
<tr>
<td>usage</td>
<td>152</td>
</tr>
<tr>
<td>Set Slot Order window</td>
<td></td>
</tr>
<tr>
<td>usage</td>
<td>120</td>
</tr>
<tr>
<td>Show All button</td>
<td></td>
</tr>
<tr>
<td>usage</td>
<td>60</td>
</tr>
<tr>
<td>-show_users</td>
<td></td>
</tr>
<tr>
<td>command line</td>
<td>216</td>
</tr>
<tr>
<td>defined</td>
<td>213</td>
</tr>
<tr>
<td>Slot</td>
<td></td>
</tr>
<tr>
<td>Create button</td>
<td>156</td>
</tr>
<tr>
<td>Queries interface</td>
<td>68</td>
</tr>
<tr>
<td>Value Type</td>
<td>107</td>
</tr>
<tr>
<td>Slot Editor</td>
<td></td>
</tr>
<tr>
<td>Edit Slot window</td>
<td>49</td>
</tr>
<tr>
<td>Slot Editor section</td>
<td></td>
</tr>
<tr>
<td>Slots window</td>
<td>45, 49</td>
</tr>
<tr>
<td>Slot ID</td>
<td></td>
</tr>
<tr>
<td>Value Type</td>
<td>52, 167, 179</td>
</tr>
<tr>
<td>Slot Name</td>
<td></td>
</tr>
<tr>
<td>Add a Slot window</td>
<td>157</td>
</tr>
<tr>
<td>usage</td>
<td>49, 157</td>
</tr>
<tr>
<td>Slots</td>
<td></td>
</tr>
<tr>
<td>add</td>
<td>45</td>
</tr>
<tr>
<td>Classes</td>
<td>46</td>
</tr>
<tr>
<td>defined</td>
<td>38, 46, 146</td>
</tr>
<tr>
<td>metadata</td>
<td>156</td>
</tr>
<tr>
<td>permissions</td>
<td>147</td>
</tr>
<tr>
<td>privileges</td>
<td>149</td>
</tr>
<tr>
<td>Slots heading</td>
<td></td>
</tr>
<tr>
<td>usage</td>
<td>43</td>
</tr>
<tr>
<td>Slots tab</td>
<td></td>
</tr>
<tr>
<td>usage</td>
<td>191</td>
</tr>
</tbody>
</table>
Slots window
  Constraints heading ................................................................. 107
  Domain .................................................................................. 53
  open .................................................................................... 107
  Slot Editor section ................................................................. 45, 49
  usage ................................................................................... 38
Sort (A to Z)
  usage .................................................................................. 60
Sort (Z to A)
  usage .................................................................................. 60
SQL server
  restart .................................................................................. 9
standard toolbar
  icons .................................................................................. 37
  location ............................................................................. 37
  title bar ........................................................................... 35
Status bar
  location ................................................................................ 35
  View .................................................................................. 36
String
  Queries interface ................................................................. 69
  Value Type ................................................................. 47, 52, 165, 167, 169, 170, 174, 179, 188
subclass relationships
  export ................................................................................ 146
system configuration
  specified ........................................................................... 6
System DSN tab
  administrator ..................................................................... 15

**T**

Teragram Semantic Term Manager
  executable ........................................................................... 6
  install ............................................................................... 24
  uninstall ........................................................................... 27
Test button
  Connector/ODBC window ......................................................... 18
Test Disabled
  usage ................................................................................ 42
TGIF field
  Classifier Concepts ............................................................... 94
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGUNLESS field</td>
<td>94</td>
</tr>
<tr>
<td>Classifier Concepts</td>
<td>36</td>
</tr>
<tr>
<td>第三数据源</td>
<td>23</td>
</tr>
<tr>
<td>TK240父槽</td>
<td>47</td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>tstmgr_commandline.zip</td>
<td>10</td>
</tr>
<tr>
<td>Type field</td>
<td>43</td>
</tr>
<tr>
<td>uninstall</td>
<td>27</td>
</tr>
<tr>
<td>Unique</td>
<td>186</td>
</tr>
<tr>
<td>Constraint</td>
<td>109</td>
</tr>
<tr>
<td>Constraint option</td>
<td>110</td>
</tr>
<tr>
<td>Value</td>
<td>186</td>
</tr>
<tr>
<td>UNIX</td>
<td>24</td>
</tr>
<tr>
<td>installation guide</td>
<td></td>
</tr>
<tr>
<td>-update</td>
<td>213</td>
</tr>
<tr>
<td>Update button</td>
<td>40</td>
</tr>
<tr>
<td>Classes window</td>
<td></td>
</tr>
<tr>
<td>usage</td>
<td>40, 49, 63, 154, 158, 166, 168, 170, 171, 175, 176, 182, 184, 188, 191</td>
</tr>
<tr>
<td>Update Instances</td>
<td>57</td>
</tr>
<tr>
<td>-update_database</td>
<td>214</td>
</tr>
<tr>
<td>command line</td>
<td></td>
</tr>
<tr>
<td>defined</td>
<td>213</td>
</tr>
<tr>
<td>Upload to TK240</td>
<td>40, 57</td>
</tr>
<tr>
<td>Use an alternate character</td>
<td>73</td>
</tr>
<tr>
<td>User</td>
<td>17</td>
</tr>
</tbody>
</table>

*SAS Ontology Management Studio: User’s Guide*
V

Value

Hierarchy Element ........................................................................................................... 110
input .............................................................................................................................. 165
Multiple Cardinality ................................................................................................... 110
Not NULL ..................................................................................................................... 110
Recursive ...................................................................................................................... 110
Unique ............................................................................................................................ 110
usage .............................................................................................................................. 110

Value field

Add a Constraint window ............................................................................................ 107
ellipses button ............................................................................................................. 111

Value heading

reorder ............................................................................................................................ 53

Value Type

Add a Slot window ........................................................................................................ 158
Class ID ......................................................................................................................... 167, 179
Constraint options ....................................................................................................... 107
drop-down list ............................................................................................................... 51
Slot ................................................................................................................................ 107
Slot ID ............................................................................................................................ 113, 167, 179
String ............................................................................................................................ 47, 165, 167, 169, 170, 174, 179, 188
Unique ............................................................................................................................ 186

Values

Instance Editor section ................................................................................................. 192
-verbose

option .............................................................................................................................. 213
option defined ............................................................................................................... 20
Warning window
   Hierarchy window ................................................................. 128
   Instances window ................................................................. 128
   Queries window ................................................................. 128
   referenced Instances ........................................................ 128
Where to store exported project file?
   Export Project Wizard ....................................................... 78
   usage ................................................................. 78, 138
Windows
   uninstall ................................................................. 27

XML taxonomy files
   categorizer ................................................................. 220
Your Turn

We welcome your feedback.

- If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).

- If you have comments about the software, please send them to suggest@sas.com.